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TTUUSS::  DDaattaabbaassee  aanndd  ggrraapphhiicc  iinntteerrffaaccee  

TUS (Tranus User Shell) is a Windows-based interactive program. It is used to build and edit the database of a 

project for the Tranus modeling system, run models, present the results of the simulations in a graphic form and 

generate reports. It is, therefore, the main tool to operate the TRANUS model. 

TUS is one of the most outstanding features of the TRANUS modeling system. The main characteristics of the 

interface are the following: 

 It contains a complete set of tools and menus to create the whole database of a Project. As described later in 

this manual, the interface provides all facilities to create and edit data, import them or export data to other 

applications. 

 The database, that has its own format, is object-oriented. This is a very important feature, because it means 

that TUS ‘understands’ what it is doing on the basis of a number of logical pre-established relationships 

between the objects at all times. For example, some vehicles may use specific link types but not others. 

Because TUS knows which are the correct ones, it will not let you put a bus route on a railway line. Some 

categories of travelers may use some but not all vehicle types, so that they will not be assigned to 

refrigerated trucks. These logical relations make the construction of the database much easier and minimize 

the possibility of errors. 

 The database deals with scenarios with special tools, rules and graphic representation of the ‘scenario tree’. 

In urban, regional and transport studies, it is common to make projections for four or five future periods in 

time and ‘with’ and ‘without’ a specific project being evaluated, such as a new road or bus system. The 

scenario tree may become much more complex if, say, different hypotheses are considered with respect to 

population growth, or if several projects are considered at the same time. Scenario trees with 50 nodes or 

more are common. In all models and GIS there is no way to deal with this, so that 50 copies of the database 

must be made and maintained, manually copying the same data on each one. This is tedious and error-prone. 

TUS, by contrast, contains all scenarios in a single database file and related every data item to the nodes of 

the scenario tree. Any change made to a data item at a particular point in time is automatically copied to all 

depending scenarios down the branch of the tree. Tools are provided to copy changes from one branch to 

another. Finally, when the models are run to simulate the various changes, all results are automatically 

stored in folders that mimic the scenario tree in an orderly fashion. 

 The interface provides a procedure to validate the data that is active at all times. Any inconsistency in the 

data is reported in real time. 

 An unlimited undo facility is also provided, together with automatic safety copies of the database. 

 Extensive context-sensitive help in English or Spanish. 

 TUS has a very simple Run menu that knows the logical sequence of the model programs and the scenario 

tree. A long batch may be created and stored for later use. 

 TUS produces interactive maps with the results of the model runs, with many options for scale, colors, 

backgrounds, etc. It is possible to consult the database with which these results were produced. The maps 

may be copied directly through cut-and-paste to any word processor or presentation program. 

 TUS provides tools to generate numeric reports of different types and formats. The resulting files are 

compatible with most common database programs such as Microsoft’s Excel or Access or the corresponding 

Open Office equivalents. 

 Any possible projection and coordinate system may be used, although the length of links is reliable only 

with UTM types. TUS can import a digital map of the study area with a specific coordinate system to serve 
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as a background display. It is then possible to code the entire network on top, taking advantage of the 

powerful network editing tools provided and the intelligent database. 

 It is possible to import/export network data with very simple text files. For example, if the network was 

coded in a GIS it is possible to export the data, possibly make a few adaptations and then import them into 

TRANUS. If, however, you are starting from scratch, you will be far better off coding the network directly 

in TRANUS, since most GIS are not design to deal with transport networks. It is also easy to export the 

results of the models for presentation in a GIS to create maps that TRANUS does not produce directly, such 

as thematic maps of population, land use, etc. 

The figure that follows shows the main components of the TRANUS system, highlighting the position of TUS at 

the center and the way it relates with the rest of the components. 

Operative components of the TRANUS system 
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MMaaiinn  wwiinnddooww  ooff  TTUUSS  

TUS displays a Main Window with the following elements: 

 

 

 

MMeennuu  BBaarr  

The Menu Bar provides commands to create and edit Project-related data and to adjust and customize the 

network views. Further below in this manual the following menus are described: File; Edit; View; Project; 

Transport; Land Use; Mouse; Paths. Menu Paths is only active when the datafile being displayed corresponds 

to a transport output (extensions P0S or T3S); in this case the menu Land Use becomes inactive. 

AAccttiioonn  IIccoonnss  BBaarr  

This bar contains a number of icons that provide direct access to frequently used tasks. These are: New, Open, 

Save and Close from Menu File; Undo from the Edit Menu; Zoom In, Zoom Out, Refresh and Show/Hide from 

the View Menu. Six additional icons change the behavior of the mouse cursor for network editing purposes. 

When the mouse pointer is placed over any of these icons, a bubble with a short text serves as a reminder of its 

function. 

Menu Bar Action Icons Bar Colors Bar 

Left Panel 

(Scenario tree) Right Panel 

(Network Views) 

Status Bar 
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CCoolloorrss  BBaarr  

This bar contains three icons and a color palette used to assign colors to the various entities of the active network 

view. With the icons it is possible to assign colors to many selected entities. The first icon, Clear Colors, 

eliminates the colors to the selected entities. The second icon, Different, randomly assigns colors to the selected 

entities up to the basic Windows’ palette with 15 colors. If more than 15 items are selected, colors are repeated. 

The third icon By Operator is only available for the network views related to operators and routes. Selecting this 

icon assigns one color to all routes belonging to the same operator. 

To manually change one or more entities, select them from the left panel and then click on the chosen color from 

the palette. Selecting a gray color (first in the palette) eliminates any previously assigned color. The network 

view will show the changes immediately. 

LLeefftt  PPaanneell  

The left panel is an expandable area that may be opened or closed at will with the Show/Hide Left Panel of the 

View menu or clicking on the corresponding action icon. When the left panel is closed, more space is made 

available to the network view. For most network views the left panel has two tabs: Scenarios and Colors. The 

only exception is the Paths view that has four tabs to show the results of the path search. 

SScceennaarriiooss  TTaabb  

Shows the scenario tree of the project. Each branch in the tree may be expanded or contracted by double-

clicking on the node. If the network view is displaying the database (tuz file), selecting any node in the tree 

changes the network view to display the corresponding scenario. If the network view is displaying results, the 

scenario tree shows the node to which the results correspond, but does not allow to move from one node to 

another. 

CCoolloorrss  TTaabb  

Shows a list f the entities related to the active network view. From the list it is possible to select one or several 

entities to assign colors to them choosing from the colors bar. The network view will show the results of the 

color scheme selected immediately. Assigning a gray color eliminates any previously assigned color. If the 

network view is displaying routes, the Colors Tab displays the list of routes. A double-click on any route triggers 

a dialog window with the corresponding data. It is also possible to select a route and then choose View – Similar 

Routes, in which case several routes maybe be colored (see details in a further section). Several routes may be 

selected with Ctrl-click, and then the selected routes may be merged together with Edit-Merge (see details in a 

further section). 

RRiigghhtt  PPaanneell  

The Right Panel is the area where the network view is displayed. It may be enlarged by shifting the left border or 

by closing the left panel altogether with the Close Left Panel button. Several tabs provide access to different 

Network Views that display specific information. Color schemes and labels may be assigned to each view 

independently. All colors and label schemes are stored, so that the next time the file is opened the network view 

appears in the same way as it was last opened. 
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In TRANUS, as against most conventional transport models, there is a single multimodal network. This has been 

very advantageous and extremely practical. The network is represented through nodes and directional links 

conforming a graph. In this way a two-way road is represented as two distinct links. 

There are four types of nodes. Common nodes are used to represent intersections or points where the 

characteristics of a link changes. For example, if a dual carriageway changes to a single lane road, there must be 

a node in between, and the transport model will analyze them separately. Centroids are special nodes 

representing zones, that is, points in the network where trips start or end. A centroid may be connected to several 

nodes in the network. There may be internal or external centroids, a difference that is important to the land use 

model. Finally there are dummy nodes to generate polylines (typical in geographical information systems GIS). 

These dummy nodes or polynodes are only used to define the geometry of a link, to represent curves or bends. 

They do have an effect in the calculation of the length of a link, as will be described later. Centroids, nodes and 

polynodes have different graphical representations in the network view, as may be seen in the following figure. 
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Note that centroids and nodes may have names and numbers assigned to them, but not polynodes. 

The right panel has a number of network views, that are displayed by selecting tabs. The number of tabs depends 

on the type of file the network view corresponds to. If it is a database file (.tuz) only four tabs are displayed. If 

the view corresponds to a path search file (.P0S), four tabs are displayed. If the file corresponds to complete 

transport assignment results (.T3S), seven additional tabs are shown. 
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NNeettwwoorrkk  VViieewwss  ––  DDaattaabbaassee  ffiillee  ((..ttuuzz))  

Datafiles with extension .tuz are the only ones that may be edited. Four network views show the network-related 

data in several ways: Link Types, Routes, Asymmetric and Changed. These are described below. 

LLiinnkk  TTyyppeess  VViieeww  

In this view colors may be assigned to each link type. Bandwidth is proportional to the capacity of links, and 

may be adjusted with the command Options of the View menu. This is the default view when program TUS 

opens. It is particularly useful to check the consistency of data related to link types and capacities. Links may be 

edited by double-clicking on them, and any change will be displayed immediately. 

RRoouutteess  VViieeww  

This view shows operators and routes, with colors selected from the Left Panel. If an operator does not have 

routes, like the private car, the corresponding color is assigned to all links where such operator may circulate. 

Bandwidth is proportional to the capacity of each route, a function of its minimum frequency and capacity of 

vehicles. Bandwith may be adjusted with the command View-Options. 

A special characteristic of the Routes View is that one or more routes may be selected from the list in Colors. If 

two or more routes are selected, the Edit-Merge command may be applied to merge the routes into one, as will 

be explained later. It is also possible to double-click on any route in the Colors list to display the data window of 

the route. Finally, if one route is selected, the View-Similar Routes may be applied, as explained later. 

AAssyymmmmeettrriicc  VViieeww  

This view shows all links in the network, highlighting asymmetric links in red. Links are considered asymmetric 

if they are one-way or, if bi-directional, one way has different physical characteristics from the other way (such 

as distance, capacity or link type). Routes may be different in one way with respect to the other. 

CChhaannggeedd  VViieeww  

This view of the network highlights in green links that have some change with respect to the preceding scenario. 

If the base scenario is selected from the scenario tree, all links will be displayed in green. If in a specific scenario 

a link is painted as changed, it may be edited to see the details of the change involved. 

NNeettwwoorrkk  VViieewwss  ––  PPaatthh  ffiillee  PP00SS  

When the active window belongs to a file of type P0S, the network view contains an additional tab called Path, 

and a menu with the same name. The Land Use menú is switched off and the Changed view is omitted. The 

remaining three views are available (Link Types, Routes y Asymmetric), as well as all the other menus. However 

these views and menus display the data but do not allow any editing.  

PPaatthh  VViieeww  

When a Path view is displayed, the Left Panel activates two additional tabs: Path and Path Link. The Path tab 

provides numerical information about the paths being displayed in the Right Panel. By default, the view displays 

the first path from the first origin zone to the second destination zone. Commands are provided in the left panel 
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to select any origin or destination zone in the form of arrows or pull-down lists. Also by default paths are 

displayed from the origin to the destination, but the reverse paths are also shown. The latter may be omitted if 

the command Don’t Show Reverse is selected from the Path menu. The Path tab also allows for the selection of 

specific travel demand categories. This will not change the configuration of the paths, but may result in different 

numeric values for generalized cost, tariffs, penalties and others. 

A table is displayed with several indicators for each path in rows, and columns for each path. The following 

values are included in the table: 

Path No. 

Generalized Cost 

Overlapped Cost 

Choice Probability 

Distance 

Travel Time 

Waiting Time 

Boardings 

Vehicle Monetary Charges 

User Monetary Charges 

Total Monetary Cost 

Delays 

If paths are not visible in the network, it may be that no colors have been assigned to the path view. 

The Path Link tab of the Left Panel describes the sequence of links and routes of the path in the form of a list. 

Each row may be selected, and the corresponding link-route is highlighted in the network view. 

NNeettwwoorrkk  VViieewwss  ––  AAssssiiggnnmmeenntt  rreessuullttss  ffiillee  TT33SS  

When a file with extension T3S is opened, seven tabs become available in addition to the four already available 

for paths. These additional tabs display the results of the transport assignment process in different ways. The 

Paths tab in this case will be identical to those displayed when a file P0S is open, except that the numeric values 

may have changed due to congestion. 

The new views related to transport assignment represent magnitudes in different units: equivalent units (eg pcu 

units). The scale in which these magnitudes are represented may be adjusted with the commands in the View-

Options menú. Colors are assigned using the color palette in the usual way. 

EEqquuiivvaalleenntt  VVeehhiicclleess  VViieeww  

This view shows the network in equivalent vehicle units, usually passenger car units (pcu). Each operator or 

route may be represented in a different color, and bandwidths may be adjusted with the View-Options menu. To 

represent total traffic, assign the same color to all operators and routes. It may be useful to assign one color to 

private operators, another color to public transport operators, and maybe a third color to freight vehicles. 

TToottaall  VVeehhiicclleess  VViieeww  

This view is similar to the previous one, except that traffic is displayed in terms of total vehicle units instead of 

equivalent units. Each operator or route may be represented in a different color, and bandwidths may be adjusted 

with the View-Options menu. It may be useful to assign one color to private operators, another color to public 

transport operators, and maybe a third color to freight vehicles. 
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VVoolluummee  VViieeww  

This view represents assigned traffic in demand units (passengers or Tons). Each operator or route may be 

represented in a different color, and bandwidths may be adjusted with the View-Options menu. It may be useful 

to assign one color to private operators, another color to public transport operators, and maybe a third color to 

freight vehicles. Note that in terms of units, passengers and freight may be incompatible, although it is common 

to represent passengers and Tons in the same scale. 

VVoolluummee//CCaappaacciittyy  VViieeww  

This view shows the Volume/Capacity ratios of each route or operator in equivalent units in each link in the 

network. Colors may be assigned to each route, and bandwidths may be adjusted with the View-Options menu, 

thus representing the contribution of each one to total congestion.  

DDeemmaanndd//CCaappaacciittyy  VViieeww  

This view shows the Demand/Capacity ratios by operator or route in each link. Colors may be assigned to each 

route, and bandwidths may be adjusted with the View-Options menu. 

SSeerrvviiccee  LLeevveell  VViieeww  

This view represents the level-of-service (LOS) in each link with a color code. LOS is calculated as the ratio 

between free-flow speed and final speed after assignment, according to the standards of the Highway Capacity 

Manual (HCM) of the US Federal Highway Administration. The HCM standard sets a scale from A to F, but 

Tranus adds two additional levels G and H. Colors may be assigned to each LOS at will, or default colors may 

be assigned with a special button in the palette. 

WWaaiittiinngg  VViieeww  

This view shows the waiting time by operator or route in each link. Each operator or route may be represented in 

a different color, and bandwidths proportional to total waiting time may be adjusted with the View-Options 

menu. 
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FFiillee  MMeennuu  

This menu contains the commands required to create, open or 

save the files related to a Project and to print the active 

network view. 

Most of the commands in the File Menu, like New, Open, Save 

(Ctrl+S), Save As, Print (Ctrl+P), Close and Exit (Alt+F4), 

are common to all Windows-based applications. 

A file must not be confused with a Window. A File 

corresponds to the database or the output of a specific 

application of TRANUS (year/policy combination). Several 

files may be opened simultaneously with the File/Open 

command, and each file is opened in a window. Several 

windows may be opened from the same file with the Window-

New command; TUS will automatically assign them the name 

of the file plus a sequential number. 

 

FFiillee  --  NNeeww  

This command is used to create a new project. Opens a new file of type .TUZ called 'New' that may be changed 

to an appropriate name with the Save As command. The only data that appears in the window is a root scenario 

called 'BASE'. This name may be changed at any time. 

To create or edit the database of the project, use the Data Input Menus. The name of the file is the one used to 

open and save it. The name of the project is defined with the Project-Options Menu. The first three characters of 

this name identify all input and output data files of the model. It is best to adopt a three-character name. 

FFiillee  --  OOppeenn  ((CCttrrll++OO))  

Displays the familiar Windows box to select a device and path and a list of files that can be opened. Only files 

with the extensions .TUS, TUZ, .P0S and .T3S are listed and may be opened. Files of type .TUZ (or .TUS in 

older versions) contain the database of a project where data may be created, edited and saved. The last two types 

correspond to the outputs of the path search program PASOS and the transport model TRANS respectively. The 

database is also present in the output files and may be displayed with the Data Input Menus, but cannot be edited 

or saved. 

FFiillee  --  SSaavvee  ((CCttrrll++SS))  aanndd  SSaavvee  AAss  

These commands are used to store the contents of the database in a .TUZ file. The files of type P0S and T3S are 

output files of model runs and cannot be saved. P0S contains the results of the path search algorithm, and T3S 

has all the assignment results. Each time a file is saved, a backup copy of the file is created and stored in a folder 

../../../Documents%20and%20Settings/Tomás%20de%20la%20Barra/Application%20Data/Microsoft/Word/Help/datainput_hlp.htm
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called backup. The name of each backup file records the date/time. If in trouble, you may open any of the 

backups with File-Open and you may Save As with a different name. 

FFiillee  --  CClloossee  

Closes the file corresponding to the active window and possible related windows. When closing a database file 

that has not been saved previously, a dialog box appears with a warning. 

FFiillee  --  PPrriinntt  ((CCttrrll++PP))  

Prints the contents of the active network view with a preset format. The image is bordered and labeled with the 

name and description of the project. The button Properties of the command dialog accesses the standard printed 

driver setup. 

TIP: Although this command works fine, it is not flexible in terms of layout. It is preferable to Edit-Copy the 

Network View and then paste it into another program with good layout options, such as MS-Word or 

PowerPoint. 

FFiillee    --  EExxiitt  ((AAlltt++FF44))  

This option closes all files and windows, and exits the Tranus User Shell. If un-saved database files are open, a 

dialog box will appear with a warning message. 

SShhoorrttccuuttss  

The following shortcut buttons related to the File menu are provided: 

 

 

 

New Open Save Close File 
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EEddiitt  MMeennuu  

Six commands are available in this menu: Undo, Copy, Delete, 

Merge, Simplify Network and Remove Network. These commands 

are described below. They are available when the active window 

belongs to a database file (extension .tuz). Output files cannot be 

edited, but the Copy command remains active. 

EEddiitt  --  UUnnddoo  

The Undo command provides one of the several ways to undo 

editions to the database. The first level of undo is provided by the 

Cancel button in all edit dialogs, which ignores the last changes 

made to the specific entity been edited. After selecting OK in any 

edit dialog, an additional Cancel button is provided in the 

command dialog, which reverses the changes made to all entities 

since the command was selected. If OK is again selected, the Undo command of the Edit Menu performs the 

same action: remove all changes made with the last command executed. Unlimited levels of Undo are possible 

until the Save command is executed. Finally, the File-Close or File-Exit commands may ignore the editions 

made in the entire working session after the last save.  

The Remove Version button present in many dialog boxes, provides a special undo feature. This button removes 

all the changes made to the selected scenario. The values of the parameters revert to those of the previous node 

in the scenario tree.  

When no changes have been made to the database, the Save command displays as Cannot Undo, to indicate that 

there are no actions to undo. The following shortcut button is available: 

 

EEddiitt  --  CCooppyy  

The Copy command applies to the active network view. The network view with all the settings and 

characteristics are copied to the clipboard and may be pasted to any other Windows application for presentation 

or reporting.  

If a rectangular section of the active view is selected by dragging the mouse, only that section of the view is 

copied. The image may be pasted to any other Windows application, such as a word processor or a presentation 

program. The image is a vector image or picture (default).  
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EEddiitt  --  DDeelleettee  ((nnooddeess  oorr  lliinnkkss))  

The Delete command acts on a selected node, a polynode, or link. The command is not available when there is 

no selection.  

Deleting a polynode ‘simplifies’ the link, since if the polynode was describing a curve, that part of the link will 

become a straight line. Deleting a node also deletes all links connected to it. When a link is deleted, the origin 

and destination nodes remain in the network. Care should be taken to avoid disconnecting transit routes when 

deleting links. Any mistake may be corrected with the Edit-Undo command. The shortcut to this command is the 

keyboard key Delete. 

EEddiitt  --  MMeerrggee  ((nnooddeess,,  lliinnkkss  oorr  rroouutteess))  ((CCttrrll++MM))  

The Merge command only acts on a selected node or link. The command is not available when there is no 

selection. Merge is a useful command for simplifying networks. TUS applies some criteria when merging. Some 

practice is required to control the results of the action. 

MMeerrggee  lliinnkkss  

To merge two links the common node between them must be selected. The selected node should not have other 

links connected to it. If several links are connected to the selected node, this command is ignored. When 

executed, the Merge command deletes the node and merges the two links into one. The length of the resulting 

link will be the sum of the distances of the merged links; the link type will be that of the longest of the merged 

links. The resulting capacity will be the smallest of the merged links (the bottle-neck). These values can be 

edited later at will by double clicking the resulting link. The Undo command reverts the action. This comand 

does not act on polynodes, since Edit-Delete serves this purpose. 

Example of the Edit-Merge command to merge two links 
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Click on the node to select the node Edit Merge (or Ctrl+M) merges the two links into one 
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MMeerrggiinngg  NNooddeess  

To merge two nodes select the common link between them. Any number of links may be connected to the origin 

or destination nodes of the selected link. When the Merge command is executed, the selected link is deleted and 

its origin and destination nodes are merged into one. All links previously connected to the origin or destination 

nodes of the deleted link will be connected to the resulting merged node. The resulting node will have the 

position of the destination node of the selected link (in traffic direction). When selecting a two way link, make 

sure to click on the side (direction) in which the nodes are to be merged. The distance of the deleted link will be 

added to all  links previously connected to its origin node. All other variables of these links will remain 

unchanged. Note that both directions of a two way link will be deleted when merging nodes. The position of the 

merged node can be changed by dragging it. The modified distances can be edited by double clicking the links. 

The Undo command reverts the action. 

Example of the Edit-Merge command to merge two nodes 
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Select link 1084-1085 Edit Merge (or Ctrl+M) drags node 1084 and merges it 

into node 1085, adjusting affected links 

 

MMeerrggiinngg  rroouutteess  

Merging two or more routes can be very useful to simplify networks. It may be the case that there are many 

routes that are very similar. This facility works very well together with the command View-Similar Routes that 

automatically finds similar routes (see later below). Both Merge and Find similar Routes work on routes of the 

same operator. For example, it is not possible to merge a bus route with a metro route. 

The following procedure is used to merge two or more routes: select two or more routes from the list in the 

Routes Network View-Colors using Ctrl+Click, or Shift+Click if the list is continuous. Then select Edit-Merge 

or Ctrl+M. The selected routes will be merged into one, adding the corresponding frequencies and itinerary. 

After merging Undo may be used to bring back the routes as they were before if the result was not satisfactory. It 

is also possible to edit the resulting route in several ways. The following figure shows an example of the Merge-

Routes facility. Note that when routes are merged, strange topologies may result, like the Y-shaped form in the 

example. TRANUS does not have a problem with such topologies, but the model user may choose to correct 

them. 



TUS: Graphic Interface and database TRANUS  

14 modelistica  

Example of the Edit-Merge command to integrate one or more routes 

  

Routes 110 and 114 are selected from the list. Edit-merge (or Ctrl+M) integrates them into one 

called 110 with the frequencies and itineraries 

added. Route 114 dissapears from the list. 

 

SSiimmpplliiffyy  NNeettwwoorrkk  

This command is used to simplify networks, transforming unnecessary nodes into polynodes, thus reducing the 

number of links and computing times, without any loss in detail. For this command to be active, an area in the 

network must be selected with Click-and-drag. Then select command Edit-Simplify Network. The procedure also 

eliminates links that are not connected to anything in all scenarios. 
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Example of simplifying a network with command Edit-Simplify Network 
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The top figure shows an area that was selected. The bottom figure shows the result of applying Edit-Simplify Network, so 

that nodes 258 to 270 have been turned into polynodes. Now there is only one link between 91 and 183. 
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EEddiitt  --  RReemmoovvee  NNeettwwoorrkk  

This command completely removes the network form the database. All other definitions of the project and data 

remain untouched. This command is useful in specific situations when mayor changes need to be done to the 

network. For instance, it may be that a first stage of a project has been made with a simplified network and a new 

stage requires a more detailed one available from a GIS or other source. Without losing the definitions and basic 

information of the project, this command removes the old network and allows for the import of a new one, 

avoiding lots of editing to accomplish the same purpose. Zone centroids are not removed, since zones may have 

a lot of associated information such as trips, households, land use, etc. 
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VViieeww  MMeennuu  

The commands in this menu control the display options of the active Network 

View. Whenever a new window is opened, all options are set to those of the 

previous occasion in which this window was opened. If a network view is opened 

for the first time, default settings are adopted. 

Previous or default options may be changed with the View Menu. Each Network 

View may have different settings of colors, scale and other view elements. Cascade 

and Tile commands are provided to arrange the different Network Views in the main 

TUS window. The system 'remembers' the settings assigned to each network view 

and applies them the next time the same window is opened. 

 

 

 

 

VViieeww  --  OOppttiioonnss  

Commands in this menu control the form in which the network is displayed and customize the representation of 

links, nodes and labels. The View-Options dialog box contains three main sections, separated with tabs: Nodes, 

Links and General. 

NNooddeess  TTaabb  

NNooddee  SSiizzee  

This scale modifies the diameter of the nodes. When editing 

the network view with the mouse, it may be convenient to 

increase the diameter to easily click and drag the nodes. 

Zone centroids are represented as squares in the graph and 

external zones are colored red. Normal nodes are 

represented as gray circles. 

LLaabbeell  WWiitthh  

Nodes may be labeled with numbers, names, or both. Select 

the appropriate option. Polynodes do not have labels. 

LLaabbeellss  OOnn  

Acts in combination with Label With. All nodes may be labeled 

or zones only. The first option may be useful in a zoom to 
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display detailed areas of the network, but in broader views labels on all nodes may be obstructive. TUS will assign to 

the nodes the type of label defined in Label With.  

LLaabbeell  SSeelleecctteedd  NNooddeess  

Assigns labels to nodes by clicking on them. The Label Icon of the Task Bar activates this option. TUS will assign to 

the nodes the type of label indicated in Label With. 

FFoonntt  

Presents a standard Windows dialog box to set font type, style, size and color to apply when labeling nodes. 

LLiinnkkss  TTaabb  

LLiinnkk  WWiiddtthh  

Modifies the width of colored links in the active network 

view. Links without color are deactivated. In some views 

the thickness of the link depends on the width factor 

(described below). It shows relative magnitudes of 

variables, such as Volume or Vehicles. Other network 

views do not relate to magnitudes, such as Routes, 

Asymmetric, Level of Service and Changes. Link width 

may be used for two purposes:  

 To emphasize the graphic magnitudes dependent 

on the width factor  

 To assign the desired width to links in network 

views that don't relate to magnitudes. 

WWiiddtthh  FFaaccttoorr  

A value that divides the variable that is being displayed to 

control the link width in the network view. If the view 

corresponds to a data file (*.TUZ) or a Path file (*.P0S), this command only has effect on the Link Types and Routes 

views. The width of each link in the graph will be proportional to the capacity of the link or the capacity of routes 

divided by the width factor. This is particularly useful to check the network data and the hierarchy of the network. In 

all other network views (Asymmetric, Changed, Level of Service and Path) the link width should be modified with the 

Link Width command described above.  

If the graph corresponds to a results file (*.T3S) this command has effect on all windows related to traffic 

assignment. The width of each link will be proportional to the magnitude of traffic divided by the width factor in 

the following windows: Equiv Veh, Total Veh and Volume. In the window Vol/Cap the width of each link reflects 

the magnitude of that relation divided by the width factor. 

SSeeppaarraattiioonn  

Modifies the gap between arcs in two way links. Move the ruler to emphasize the difference in volume or capacity in 

each direction of the link. 
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HHiiddee  ggrraayyeedd  lliinnkkss  

This option hides all un-selected links, or links that have not been assigned to a color. Particularly useful when a 

background map is displayed (see later below) and links that have not been selected are wanted out of the way. 

LLaabbeell  LLiinnkkss  WWiitthh  

Presents a pull-down list to select among several attributes: 

 (nothing) 

 Id (identification number of the link) 

 Capacity 

 Delay 

 Description 

 Equivalent vehicles (*) 

 Length 

 Name 

 Service Level (*) 

 Speed 

 Total vehicles (*) 

Choose an option to display labels over links. Link labels are displayed only if there is enough space. When the 

view is zoomed-in, more link labels appear. If the value is the same in one direction and the other, only one 

value is displayed. Attributes with (*) are only meaningful if the file being displayed corresponds to results. If a 

database file (TUZ) is displayed, no values are presented. In the case of speed, if a database file is displayed, the 

free-flow speed is presented; if a results file is being displayed, speed will correspond to the congested speed 

after assignment. 

FFoonntt  

Presents a standard Windows dialog box to set font type, style, size and color that will apply when labeling links. 

GGeenneerraall  TTaabb  

Presents a single value called Scale that determines the scale at which the network view is being displayed. 

Particularly useful when several network views are required at exactly the same scale. 

VViieeww  AAllll  ((CCttrrll++AA))  

This command zooms the active network view so that the whole extent of the network is displayed. It is common 

to use this command to see all the study area and then select (by dragging with the mouse) a rectangle of interest 

and zoom in, or find a node with View-Find Node and then zoom in.  
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VViieeww  RReeffrreesshh  ((FF99))  

Some operations like scroll or zoom may litter the screen with lines or simply distort the view, especially when 

using a PC with limited graphic memory. This command redraws the network view. Alternatively click on the 

Redraw icon in the tool bar. 

VViieeww  FFiinndd  NNooddee  ((CCttrrll++FF))  

Locates a specific node in the network view. The command displays a pull-down list of nodes. Selecting one 

node from the list, moves the network view to place the target node in the center of the window, highlighted with 

a blue square. Typing the node number in the pull-down list provides a fast search procedure. 

VViieeww  FFiinndd  LLiinnkk  ((CCttrrll++GG))  

Locates a specific link in the network view. The command displays a pull-down list of links with their 

corresponding Id numbers. Selecting one link from the list moves the network view to place the target link in the 

center of the window, highlighted with a blue line. Typing the Id number in the pull-down list provides a fast 

search procedure. 

VViieeww  FFiinndd  ssiimmiillaarr  rroouutteess  

This command is used to find similar routes to a specified target route. It is particularly useful to simplify a 

network, reducing the number of routes. The network view must correspond to the Routes view. Preferably set 

all colors to gray. In colors, select a specific route from the list, and then choose the command View-Find similar 

routes. The network view will show the results of the search with the target route in red and the rest of the routes 

with random colors. See the example below. The search procedure will look for routes of the same operator as 

the target and that share the same links up to a specified percentage. The percentage is specified in Project-

Options as a Route Similarity Factor. For example, specifying 80% means that the search procedure will look 

for all routes of the same operator as the target and that share at least 80% of link lengths. Note that link lengths 

are taken into account. Once all similar routes have been found, you may apply Edit-Merge (or Ctrl+M) to turn 

all similar routes into one, adding frequencies. 
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Example of the result of the Find Similar Routes command 

 

The target route is displayed in red and all similar routes are assigned random colors. 

VViieeww  ZZoooomm  OOuutt,,  ZZoooomm  IInn  ((FF77  --  FF88))  

These commands cause the graph in the active window to be reduced or enlarged in scale by one step. These 

options may be selected directly with the Zoom In/Out icons of the tool bar. 

VViieeww  SShhooww//HHiiddee  LLeefftt  PPaanneell  

Opens or closes the left panel of the window to leave more space for the network view. A shortcut icon is provided in 

the tool bar. 

VViieeww  --  BBaacckkggrroouunndd  FFiilleess  

Opens one or several digital maps in DXF files and puts them as a 

background to the network views as layers. Each layer may be 

moved up or down and a different color may be assigned. This 

feature may be useful to add background context to the network 

views, such as rivers, coastlines, lakes, roads, and so on. It is 

particularly useful when coding a network: a detailed street map with 

geographical coordinates may be put as a background and the 

powerful network editing tools used to code the network on top. For 
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this it is important that the DXF file has the correct coordinate system. 

This command opens a window with Add and Remove buttons to add or remove layers. When the Add button is 

activated, a typical File-Open window pops up looking for DXF files. Up and down arrowheads are used to 

promote or demote individual layers. A pull-down box is used to assign colors to each layer. The Remove button 

removes a selected layer. 

The examples that follow illustrate the potential of these facilities. 
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Without a DXF background 
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18 Oropeza Castillo

23 Mare Mare

24 Las Villas

25 Las Garzas

32 El Morro

33 Pueblo de Lecheria

34 Lecheria

35 Plaza Mayor

 

A DXF file with a detailed street map has been added to improve the presentation. Note that the centroid connectors have been made 

invisible with the Hide grayed links option of the View–Options-Links command. 
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Av C

3 Bobure

4 Guanta

5 Chorreron

6 Puerto de Guanta

7 El Chaure

8 Guaraguao

9 Refineria PDVSA

10 Las Delicias

11 Casco de Puerto La Cruz

12 Barrio El Pensil

13 Barrio Obrero

14 Chuparin

15 El Ferry

16 Bella Vista

17 Provisor

18 Oropeza Castillo

19 El Maguey
20 Sierra Maestra

21 La Caraqueña

22 Pozuelos

23 Mare Mare

24 Las Villas

25 Las Garzas

26 Mayorca

27 UDO

32 El Morro

33 Pueblo de Lecheria

34 Lecheria

35 Plaza Mayor

 

A DXF street map was opened as a background. Then some bus routes were selected and colored. Finally the Hide grayed links of the 

View-Options-Links command was used to ‘hide’ the rest of the coded network. 

 

 

SShhoorrttccuutt  iiccoonnss  ooff  tthhee  VViieeww  MMeennuu  
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NNeettwwoorrkk  eeddiittiinngg  ttoooollss  

The toolbar provides a set of tools for the interactive edition of the network. The same tools may be selected 

from the Mouse menu. The following buttons are provided and described further below: 

 

 

 

 

 

MMoovvee  NNooddeess  

With this button, the cursor or pointer looks like a cross-hair and is enabled to move nodes by clicking and 

dragging them around. All links related to the node are adjusted and dragged along accordingly, but link 

lengths are not modified. This is useful to move nodes away from a congested area and gain clarity. Later on, 

the length of links may be changed individually (Transport-Links command) or globally (Project-Options 

command). 

LLaabbeell  NNooddeess  

The command View-Options-Nodes provides facilities to label nodes with Id numbers, names or both. Labels 

may be put on zones only, on all nodes or on ‘selected’ nodes. The function of the Label Nodes button is to 

select which nodes are labeled in the network view, provided that the Selected Nodes of the View-Options-Nodes 

option is active. In this mode, the pointer shows a small label. Clicking on a node selects it for labeling. 

CCrreeaattee  NNooddeess  

The pointer looks like a circle. Clicking on any point opens the Nodes Edit dialog, showing a default Id number 

assigned to the new node (last Id + 1) , and the coordinates of the point. The Id number may be changed (avoid 

repeated Id numbers) and a name and description may be added to the node. Use Ctrl+Create Node to add a new zone 

with an Id number and name, and specify if it is internal or external zone. 

Note that most network views don’t show nodes that are not used (i.e. with no links associated to it) in the 

scenario being displayed. Only the Changed view displays all nodes. Consequently use this view when creating 

new nodes. 

The command Create Nodes does not create polynodes. For this purpose use the Split Link command described 

further below. 

CCrreeaattee  LLiinnkkss  

Used to create a new link between two existing nodes. The pointer looks like a bar when positioned over a node. 

Select the origin node and drag the pointer to a destination node. The Links Edit dialog opens, showing the 

origin-destination of the new link created as a two-way link by default. This condition may be changed and the 
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remaining data assigned (length, capacity, link type). By default the length of the link is calculated from the 

nodes coordinates, assuming a straight line. 

SSpplliitt  LLiinnkkss  

Double clicking on a link in this mode divides it into two halves. The Nodes Edit dialog opens showing a default 

number Id for the new node created and its coordinates. This Id number may be changed, and a name and description 

may be added. Each half link will have the following characteristics: 

 half the length of the original 

 same link type as the original 

 same capacity as the original 

 same routes as the original 

 same name and description 

Note that links are split for the active scenario and its dependents down the scenario tree, with the new links with 

the condition Used and the original link as Not Used. For all other scenarios, the original link remains as Used 

and the new couple of links as Not Used. 

Use this mouse mode to create intermediate nodes to describe a curve in more detail. Then select a node and use 

Edit-Simplify Network to turn it into a polynode. You may select many nodes by using click-and-drag. 

DDeeffiinnee  RRoouutteess  

This pointer mode is only available in the Routes tab. To assign a route to a link, first select the scenario from 

the tree, then select a route from the list in the Color tab of the left panel, and select the Define Route button. 

The route is assigned to a link by clicking on the link. The following rules apply: 

 The selected route may be assigned to many links with subsequent clicks until the Define Route button 

is deactivated. 

 The Undo command of the Edit Menu (or the Undo button) reverts all assignments made since the 

Define Route button was selected. 

 If the selected route had not been assigned to the link, this button assigns the route and declares it as 

Passes and Stops (see command Transport-Route) 

 If the route had been previously assigned to the link and is either in the condition Passes and Stops or 

Passes Only, this button will declare it as Cannot Pass for the current scenario and its dependents. 

 The route will be assigned in the direction in which the mouse-click was made. If the route passes both 

ways, click both ways. 
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DDaattaa  mmeennuuss::  

((PPrroojjeecctt,,  TTrraannssppoorrtt  aanndd  LLaanndd  UUssee))  

Three menus are used to view, create and edit data: Project, Transport and Land Use. All commands in these 

menus operate in a similar way and present the same buttons and tools. This section explains the way in which 

data editing boxes are used in general. 

Data menus may have one of two conditions. If the active file corresponds to a project database (extension .tuz) 

data may be created and edited for any scenario in the project. If the active file corresponds to model results 

(extensions .P0S or .T3S), these commands are used to view the data for the corresponding scenario only, but 

data cannot be changed. 

Most of these commands operate in a similar way. A main dialog is presented first, with a list of entities in a 

right panel and the scenario tree in the left panel. If the active file is the database, any scenario may be selected 

and the list to the right changes accordingly. If the active file corresponds to model results, the scenario tree is 

still shown but moving to other scenarios is not allowed. 

EEnnttiittiieess  BBuuttttoonnss  

As shown in the figure, the 

main dialog box has several 

buttons around the two panels. 

OK and Cancel accept or 

discard possible changes made 

to any of the entities in the list. 

New and Edit are used to create 

new entities or edit a 

previously selected entity from 

the list. The Delete button 

completely removes the entity 

from the database (use with 

caution). Most dialogs also 

include a Copy button, to be 

used when a new entity is to be 

added to the list with similar 

characteristics to a previously 

selected entity. The latter is particularly useful for complex entities such as a bus route that includes a sequence 

of links. If a new route is to be added with an itinerary similar to an already defined route, the Copy button may 

be used to create an identical route and then edit the changes. 

The dialog boxes that pop-up when an entity is edited or created also contain OK and Cancel buttons. Some 

dialogs have an additional button to open related objects to which the entity is related. For example the Route 

dialog has a button Operator, that in turn opens the dialog of the operator the route belongs to. In turn the 
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Scenario 
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Entities buttons 

List filters 

Scenario buttons 
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Operator box has a button Mode that opens the mode box to which the operator belongs to, and so on, following 

a logical chain. 

NNeeww  eennttiittiieess  

If no entities have been defined, the main dialog box is empty. The New button creates new entities and adds 

them to the list. The button opens the corresponding dialog with fields of data to fill in. Once data has been 

introduced, the OK button returns to the main dialog box to create more entities or to edit existing ones. 

EEddiitt  ddaattaa  

To edit data related to an entity, select the entity from the list and press the Edit button, or double-click the entity 

in the list. The corresponding dialog opens and displays the data. Modify any value and use the OK or Cancel 

buttons to return to the main dialog window. 

All data dialogs have a Left Panel with the scenario tree. Navigating the scenario tree displays the data on the 

Right Panel. A gray square indicates if the node in the scenario tree has no changes with respect to the scenario it 

depends from. The square turns green if there are changes. Similarly, values in the Right Panel are presented in 

gray font if they do not represent changes with respect to the previous node in the scenario tree, and in green font 

if they do. All data is subject to a permanent validation, such that if an inconsistency or omission is found, the 

font turns red and the corresponding square in the scenario tree also turns red. Positioning the cursor over the 

offending value displays a bubble with a short sentence describing the nature of the offence. 

When the active file corresponds to model results, the Edit button changes to View, since values cannot be 

edited. 

VViieewwss  iinn  tthhee  mmaaiinn  ddiiaalloogg  

The Right Panel shows a list of the entities that have already been defined. Pressing the right button of the mouse 

displays a small box called View By with two options: List and Details. The first option shows the list with Id 

numbers only so that a large number of entities may be accommodated. The second option (default) displays the 

Id number, name and description. 

LLiisstt  FFiilltteerrss  

The main dialog box has three buttons to filter the entities in the list: 

 

 

 

Show All (default) indicates that no filter is being applied, that is, the list includes all entities. To the left of each 

entity in the list a square may be gray, green or invisible: 

Show All Show Used Show Changed 
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Gray: the entity is used in the active scenario and all its data remains unchanged with respect to the 

previous scenario up the tree 

Green: the entity is used in the active scenario and some of its data has been changed with respect to 

the previous scenario up the tree 

Invisible: the entity is not used in this scenario 

When the Show All filter is selected, all entities are in the list, with gray, green or invisible squares. 

When the Show Used filter is selected, only entities used in this scenario are listed, whether gray or green. 

When the Show Changed filter is on, the list only includes entities that have some change in the current scenario, 

that is, only those with a green square. The list may be empty. In the base or root scenario all entities are either 

green (modified) or not used. 

SSeeaarrcchhiinngg  ffoorr  aann  eennttiittyy  iinn  tthhee  lliisstt  

TUS provides a search engine to look for a specific item in a list. Select any item in the list and type the Id 

number of the entity being searched for. Particularly useful when there are long lists, such as nodes or links. May 

require a bit of practice. 

UUnnddoo  ffuunnccttiioonnss  

An important feature of TUS is that there are several ways to undo the edits made to the database in a work 

session. The first one is the Cancel button in all edit dialogs, which discards any changes made to a specific 

entity being edited. A second Cancel button in the main dialog box that discards all possible changes made to all 

entities since dialog was opened. The third one, is the Undo command in the Edit Menu (or button) with 

unlimited levels, that sequentially undoes each command executed by the user, from the last to the first since the 

last Save. The Cancel command on the File-Save Menu discards all the edits performed in the work session after 

the last Save. The same action occurs wit the Exit command, which prompts the user to save the changes.  

SScceennaarriioo  bbuuttttoonnss  

Three additional buttons are provided to manage data along the Scenario Tree: 

 

 

 

 

Select a node in the Scenario Tree, and then: 

 The Remove Version button removes all changes made to the entity in the selected scenario. All values 

return to those of the previous scenario.  

 The Copy Scenario button copies all changes in the selected scenario node to memory. 

Remove 
Version 

Copy 
Scenario 

Paste 
Scenario 
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 The Paste Scenario button copies all changes stored in memory from a previous scenario node to the 

selected scenario node. 

To copy all changes from a source scenario node to a destination node: select the source node; click Copy Scenario; 

select the destination node; click the Paste Scenario button. Alternatively select the source node and drag it on to the 

destination node. 

If the above procedure is made when a single entity is being edited, only the changes for that specific entity and 

scenario node are copied, pasted or removed. If a whole list is active, all changes in the list are copied, pasted or 

removed. The highest level is the Project-Options menu where the indicated procedures will apply to a complete 

scenario node dataset. 
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PPrroojjeecctt  MMeennuu  

This menu deals with project-wide data and commands. It is 

organized into four groups of commands.: 

Project Options. Used to define and edit the Scenario Tree 

and to set a number of general options and parameters that 

apply both to land use and transport. 

Zones. Used to define and edit zones. Before introducing any 

zone-related data, zones must be defined. 

Validate and Generation of Files. Performs a number of 

checks to the data and presents a validation window listing 

possible errors or warnings. File Generation automatically 

generates the data files needed to run the Executable 

Programs. 

Export/Import Network. Commands to export data from the 

TRANUS database to other transport or traffic models or to 

GIS databases, or to bring data from other applications into 

TRANUS. A command is also provided to generate a complete XML version of the database. 

PPrroojjeecctt  --  OOppttiioonnss  

Used to define and edit the Scenario Tree and to set a 

number of general options and parameters that apply 

both to land use and transport. A general identification 

of the project is specified here, as well as some global 

parameters for the land use and transport models. 

The Definition of the project includes the Name, a 

Description (optional) and an Author (optional). Only 

the first three characters of the Name are used by the 

programs to construct names of files, so that it is 

important to choose appropriate ones. 

Three sections define the Coordinates system, some 

global Transport parameters and global Land Use 

parameters. These are described in sections below. The 

Left Panel shows the Scenario Tree and provides tools 

for defining, editing and copying scenarios. 

 

CCoooorrddiinnaatteess  TTaabb  

Here the program is told which coordinate system is being used, and the units link lengths are measured. This 

will affect the way in which the network is displayed and the way in which link lengths are calculated. The 

following options are provided: Windows or Cartesian (geodesic or UTM). Windows coordinates are hardly 

used, with the origin in the upper-left corner and the Y axle growing from top to bottom. Instead, with Cartesian 

Help/ExecutablePrograms.htm
Help/ExecutablePrograms.htm
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coordinates the X and Y axles growing from left to right, and bottom to top. Select this option when working 

with UTM coordinates. 

LLiinnkk  LLeennggtthh  MMuullttiipplliieerr  

When calculating link lengths from node coordinates, the given value is used as a multiplier for the length. This 

allows, for example, to have node coordinates in meters (UTM, for example) and link lengths in kilometers (x 0.001).  

RReeccaallccuullaattee  LLiinnkk  LLeennggtthhss  

Recalculates all link lengths for the current scenario using the previous parameters.  

TTrraannssppoorrtt  TTaabb  

Provides some project-wide parameters for the transport model. 

IItteerraattiioonnss  aanndd  CCoonnvveerrggeennccee  

The transport model will iterate until the convergence target is met, up to the maximum number of iterations. 

Convergence is evaluated as the maximum difference in assigned volumes and speeds between the current and 

previous iteration over all links in the network. 

SSmmooootthhiinngg  FFaaccttoorr  

At the end of each iteration the resulting values (speeds and waiting times) are averaged with those of the 

previous iteration. The smoothing factor parameter weights the values of the previous iteration to smooth 

convergence. The default value is 1. 

RRoouuttee  ssiimmiillaarriittyy  ffaaccttoorr  

This parameter is used to find similar routes to a target route. See the View – Find similar routes command. 

MMooddeell  

Two choice models are provided: logit or powit. Use this checkmark to select the one you want to use in the 

transport model. 

LLaanndd  UUssee  TTaabb  

IItteerraattiioonnss  aanndd  CCoonnvveerrggeennccee  

The land use model will iterate until the convergence target is met, up to the maximum number of iterations. 

Convergence is evaluated as the maximum difference in assigned production between the current and previous 

iteration over all zones. 
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SSmmooootthhiinngg  FFaaccttoorr  

At the end of each iteration the resulting values (production and prices) are averaged with those of the previous 

iteration. The smoothing factor parameter weights the values of the previous iteration to smooth convergence. 

The default value is 1. 

MMooddeell  

Two choice models are provided: logit or powit. Use this checkmark to select the one you want to use in the land 

use model. 

ZZoonnee  FFaaccttoorr    

The transport model ignores intrazonal costs and disutilities. The land use model, however, requires these values 

to allocate production from demand zones. These are calculated as a proportion of the cost and disutility of the 

nearest zone, i.e., the zone with the least disutility. The Zone Factor is the proportion applied to get the internal 

cost and disutility for each zone. By default, the resulting value is applied to all zones, but individual values may 

be set with the Zones command of the Project menu.  

SScceennaarriiooss  

A scenario is a combination between a year and a policy. Scenarios are organized in the form of a scenario tree, 

in which each element depends on a previous one. The root of the tree is the base scenario. Each scenario is 

uniquely defined with a three character Name. Usually the first two characters symbolize the year and the third 

character defines the policy (eg 93A, 05F, etc). 

With an active window belonging to a data file, scenarios may be created or edited in the Project-Options command 

of the Project Menu with the following buttons located on top of the scenario tree: 

 

 

 

AAdddd  SScceennaarriioo  

This button is used to create a new scenario and to assign a three-letter code and name. A previous scenario must be 

assigned to each new scenario. The resulting outline of the tree is presented. Most dialogs of the Data Input Menus 

also display the scenario tree to select the scenario where editions have to be made. Data created or edited in a 

scenario are automatically copied to all dependent scenarios down the branches of the tree.  

EEddiitt  SScceennaarriioo    

The name and description of the selected scenario may be edited but the assigned precedence (the previous scenario) 

cannot be changed. If a wrong precedence was defined, delete the scenario and create it again with the correct 

precedence.  

Edit Add Remove 
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RReemmoovvee  SScceennaarriioo  

Selecting this button deletes the selected scenario from the tree. Dependent scenarios will also be deleted with all 

corresponding data. Previous scenarios will remain intact. If there is an accidental deletion use the Cancel button or 

Undo.  

RReemmoovvee  VVeerrssiioonn  

With this button all editions made to the selected scenario are removed. All variables and parameters will remain the 

same as the previous scenario in the tree. The Cancel button reverts the action. 

CCooppyyiinngg  SScceennaarriiooss  

All data related to a specific scenario may be copied to another scenario. First create the new scenario and then copy 

the source scenario to the destination one. Click on the source scenario and the Copy button; select the destination 

scenario and the Paste button. Alternatively drag the source scenario and release the mouse button over the 

destination scenario. The destination scenario can then be modified at will. 

PPrroojjeecctt  --  ZZoonneess  

 

 

The study area must be divided into zones, and these must be defined before any zonal data can be introduced. 

There are two types of zones: internal and external. The Project-Zone  command is used to create or edit zones, 
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assign an Id number, a short name and a description, and geographical coordinates. The checkmark External 

defines the zone as external. 

In the activity model, no production takes place in external zones. They are only used to simulate imports and 

exports. Also many applications use external zones to input exogenous trips into the transport model. 

When a zone has been defined, the database automatically creates the corresponding node in the network. Nodes 

may be seen in the network view and with the Nodes command of the Transport menu.  

Zones definitions, names and coordinates may be imported from a file. (See the section Importing and Exporting 

Data). Since zones are also nodes, the same procedure to import and export nodes is valid for zones.  

PPrroojjeecctt  --  VVaalliiddaattee  

The Validate command of the Project Menu performs an overall validation of data of a specific scenario, and 

opens a window with the list of errors or warnings found and a short definition of the problem. Selecting a 

message and the Edit button (or double-clicking the message) opens the corresponding dialog box where the 

problem should be corrected, highlighting the offending data in red. The scenario where the error was 

encountered will have a red square in the scenario tree on the left panel. Correcting the error returns to the 

validation list where the previous problem should have disappeared. Run the Validate procedure as many times 

as necessary until an empty window is generated with no messages in it. 

GGeenneerraattiioonn  ooff  iinnppuutt  ffiilleess  

Automatically generates the data files needed to run the Model Programs. Any change made to the data of a 

specific scenario means that the models must be run again in order to calculate the effects of such changes. Three 

optional commands are provided: Generate Input Files, Generate Single Scenario and Generate Single File. 

Note that if the menu Project → Run, described below, is used, these commands are not necessary, since the Run 

command generates the files automatically. 

PPrroojjeecctt  --  GGeenneerraattee  IInnppuutt  FFiilleess  

Generates all input files for all scenarios in the project, including batch files to run the programs. This is the 

recommended option to make sure all data is consistent. Even in large applications file generation takes only a 

few seconds. Using the Project – Run command applies this option automatically. 

PPrroojjeecctt  --  GGeenneerraattee  SSiinnggllee  SScceennaarriioo  

This command generates all input files related to a specific scenario. A dialog box appears showing the scenario 

tree to select the single scenario for which files will be generated.  

PPrroojjeecctt  --  GGeenneerraattee  SSiinnggllee  FFiillee  

This command requires good knowledge of the TRANUS operating structure, since users have to choose which 

file to generate. Clicking on this menu presents a secondary menu with all TRANUS file types. The scenario tree 

is presented next to complete the selection. For most users this command is not recommended, since it does not 

guarantee the consistency of data, and generating all files takes only a few seconds. 
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PPrroojjeecctt  →→  RRuunn  

The process of running the model programs has been automated in the Tranus interface, making it easy and safe. 

This is the purpose of menu Project  Run, that will run the model programs, without having to use the file-

generation commands described above. This menu displays the following window: 

 

 

The window shows the scenario tree to the left. In the Run these programs section it is possible to chose between 

running all programs related to a particular scenario, or just a selection. Whatever the selection, the Add to 

Batch button adds the tasks to the list to the right. You can continue adding tasks at will, and tasks may be 

removed from the list with the corresponding button. The list of tasks may be saved with the Save Batch button 

or a previously saved list may be loaded with the Load Batch button. When satisfied with the list, the Run button 

performs the tasks. The window changes its appearance to display messages reporting on progress as shown in 

the figure below. The Programs Operation Manual provides a detailed description of the meaning of these 

progress reports. Once calculations have finished, the Close button closes the window. 
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When Selected Programs is chosen, an additional option is offered to the Location model called Fixed 

Transportables. This option is only available when the chosen scenario corresponds to the Base Case (i.e. root 

of the scenario tree). The effect of this option is that the production of all induced transportable sectors is frozen 

and made equal to the data as exogenous production. This means that the model will only adjust the non-

transportable sectors, typically land of several types. This facilitates the estimation of the elastic demand 

functions for land. Additionally, because all transportable sectors are frozen, no flows are generated and no 

transport disutilities are required. The latter means that the location model and the transport model may be 

adjusted separately at the beginning. 

IImmppoorrttiinngg  aanndd  eexxppoorrttiinngg  nneettwwoorrkk  ddaattaa  

This section of the Project menu contains commands to export or import network data in standard text form. Use these 

commands to export data from the TRANUS database to other transport or traffic models or to GIS databases, or to 

bring data from other applications into TRANUS. A command is also provided to generate a complete XML version 

of the database. Three commands are provided: Export Network, Import Network and Export to XML. 

EExxppoorrtt  NNeettwwoorrkk  

This command automatically generates a set of text files with all network-related data for a specific scenario. 

Separate files are generated for nodes, links, transit route definitions, transit itineraries and turns. When this 

command is selected, a window with the Scenario Tree is presented. Selecting a specific node in the scenario 

tree determines which network is generated. 

A practical use of the Export Network command is to obtain a list of links that may be edited with a spreadsheet 

or a database program or a GIS. In this way the data manipulation facilities of these programs may be used 

advantageously. Once the changes have been made, the list of links may be imported again into the Tranus 

database. 

The type of file managed by TUS follows the standard known as ANSI Latin1 (ISO 1059, or MS Windows 

ANSI). These are text files with data fields separated by commas and the end of registers with line feeds. The 
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network data is organized in five files for each scenario: nodes, links, routes definition, routes assignment to 

links or itineraries, and turns. 

NNooddeess  ffiillee  

The default name of the file is the same name given to the project, with the extension 'nodes' (Project.nodes). 

Contains one record for each node of the exported network with the following comma separated fields: 

Node Id, X Coordinate, Y Coordinate, Zone Indicator, 'Name', 'Description'  

Node Id is a unique node identification number, a positive integer 

X and Y coordinates of the node  

Zone Indicator can take one of three values: 1 if the node is an internal zone; 2 for external zones and 0 

for any other node  

Name and Description are optional text fields  

LLiinnkkss  ffiillee  

The default name of the file is the same name given to the project, with the extension 'links' (Project.links). 

Contains one record for each link of the selected scenario in the exported network, with the following comma 

separated fields: 

Link Id, Origin, Destination, Direction, Link Type, Distance, Capacity, 'Name', 'Description'  

 Link Id is an identifying number of the link  

 Origin and Destination are the Node Id of the nodes that define the link  

 Direction has one of two values: 1 for one-way links, 2 for two-way links (*) 

 Link Type is the code or Id number of the link type to which the link belongs (**) 

 Distance of the link or link length  

 Capacity of the link in traffic units, normally in standard vehicles per hour or PCU (***) 

 Optional name and description as text fields 

(*) A two-way link may be coded as two separate one-way links. 

(**) Link type = 0 if the link is not used in the scenario 

(**) An undefined or infinite capacity is coded as -1. 

RRoouutteess  ddeeffiinniittiioonn  ffiillee  

This file contains a list of all routes in the network with basic characteristics. A separate file described below 

contains the itineraries of the routes, that is, the set of links in which the route provides a service. The default 

name of the file is the same name given to the project, with the extension 'opers' (Project.opers). The file 

contains a record for each route, with the following comma separated fields:  

Route Id, 'Name', 'Description', Operator, MinFreq, MaxFreq, Fleet  

Route Id is an identifying number of the route  

Name and Description are optional text fields 

Operator is the Id number of the operator to which the route belongs  
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MinFreq and MaxFreq define a frequency range from minimum to maximum  

The Fleet field is not used in the current version  

RRoouutteess  aassssiiggnnmmeennttss  ttoo  lliinnkkss  oorr  iittiinneerraarriieess  ffiillee  

The second route file contains route assignments to the network. The default name of the file is the same name 

given to the project, with the extension 'routes' (Project.routes). For each route, the file contains a record for 

each link to which the route is assigned. The file has the following comma separated fields:  

Origin, Destination, Route ID, Use  

Origin and Destination are the node Ids of the of the link the route is assigned to 

Route Id is the code of the route in the database 

Use is an integer with two possible values: 1 if the route uses the link but cannot stop in it; 2 if the route 

passes and stops. 

TTuurrnnss  ffiillee  

Contains records to describe possible turn delays or prohibitions in the network. The default name of the file is 

that of the proyect with extension ‘turns’ (Project.turns). The file has the following comma-separated fields: 

From, Thru, To, Delay 

From, Thru, To are the node Ids that identify the turn 

Delay is the delay time (if the turn is prohibited, delay = ‘INF’) 

IImmppoorrtt  NNeettwwoorrkk  

This command is used to import into the TRANUS database external data related to the network for a specific 

scenario. A dialog similar to a File-Open window pops up, listing files corresponding to nodes, links, route 

definitions, route itineraries or turns. Once a file is selected, another window with the scenario tree is presented 

to specify which scenario the data must be imported into. File formats are exactly the same as those generated 

with the Project-Export Network command. 

It is often useful to export the network data, then open and edit the files with a spreadsheet, perform some global 

edits, and finally re-import the file back into the Tranus database. For example, the easiest way to multiply the 

capacity of all links of a specific type by a factor of 1.2 is to export the network, open the links file with Excel, 

filter all links of the specified type, multiply the capacity by the factor and re-import the link file back into the 

project database. 

The import command is also very useful to transfer the network data from another model, such as EMME/2, 

Trips, TransCAD, or from a GIS database into Tranus. The export command may be used for the opposite 

purpose, such as presenting the network in the Tranus database in a GIS platform. It may be very useful to 

export and import network data to and from a traffic simulation model, such as Transyt or Synchro. Special 

facilities are provided for this purpose. 

The list of nodes, links or routes being imported does not have to be a complete list. For example, a small list of 

additional links may be imported to a previously defined network in the Tranus database. In this case, the new 

list is simply added to the previous list. If the new list being imported contains nodes, links or routes that were 

already in the database, the new definitions replace the previous ones. 

When importing a complete or partial list, consider the following: 
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 If the list of nodes. links, or routes contains repetitions, that is, records with the same Id number or the 

same origin and destination numbers, the data of the last occurrence prevails. 

 If the list contains an entity (node, link, etc.) that already exists in the Tranus database, the new version 

being imported replaces the previous one. 

 If the list of links contains origin and/or destination Ids that have not been defined previously in the 

Tranus database to which the data is being imported, they are created with blank names and 

descriptions and with X=Y=0. 

 If the list contains an operator Id that has not been previously defined in the Tranus database, the 

operator is created with default parameters. 

 If the list of routes assignments contains node Ids that have not been previously defined in the database, 

they are generated with blank names and descriptions and X=Y=0. If the list contains a Route Id that 

has not been previously defined, it is generated with default parameters and assigned to a new operator. 

For the above reasons it is recommended that files are imported in the correct sequence: nodes, links, routes 

definitions and routes assignments. 

EExxppoorrtt  ttoo  XXMMLL  

With this command exports the entire database contained in the TRANUS to a XML file. The format 

corresponds to the standard of the Extended Markup Language to describe distributed data. Information and 

instructions to manage XML files may be found in the site http:\\www.w3c.org. This command offers two 

options: with or without compression. In the first case an ASCII file with extension .xml is created with the 

complete database in XML form. In the second case the same file is generated but compressed and with the 

extension .xmlz. 
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TTrraannssppoorrtt  MMeennuu  

These commands are used to manipulate all transport-specific entities and 

related data. If the active file is a database (.tuz) these commands are used 

to create entities and data or edir existing ones. If the active file 

corresponds to results (.P0S or .T3S), these commands are used to diplay 

data only. 

When a new database is being created, only a few submenus are active. 

This is because some entities depend on others and, consequently, some 

entities must be defined first. For instance, operators depend on a mode, 

so that before any operator may be defined, at least one mode must have 

been created. 

TTrraannssppoorrtt  CCaatteeggoorriieess  

Transport demand is classified into transport categories. Each category 

combines a particular trip maker type and a purpose of the trip, e.g. low-

income people traveling to work or high-value commodities. A category may use some transport modes, but not 

others. For example, freight trips may not use public transport. 

Buttons are provided to edit an already defined category or to create a new one. A new category may also be 

created by copying an existing one with the copy button. If a new category is being created, an Id number, short 

name and description must be given. Then the data is specified in three sections: 

 Data Section 

 Choice Section 

 Available Modes Section 

DDaattaa  SSeeccttiioonn  

Value of Travel Time: Monetary value that a transport category assigns to one unit of travel time. Units must be 

consistent with other variables in the model. 

Value of Waiting Time: Monetary value that a transport category assigns to one unit of waiting time. Units must be 

consistent with other variables of the model. 

% of Vehicle Availability: Proportion of passengers of a transport category that have a vehicle available to make 

the trip. Different from car ownership: a car is not necessary owned, but available, e.g. students taken to school 

in parents' car. Only makes sense in passenger categories. This parameter is available mostly for compatibility 

with older versions of the model and other models, but is not recommended. Instead define this percentage as 

100% and use modal constants by category, as defined in Transport→Operators→Categories. 

Minimum Generation Rate: First parameter of the elastic trip generation function in the transport model. It is 

the minimum amount of trips per unit of flow of the category in the time period of simulation, when travel 

disutility is close to zero. 
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Maximum Generation Rate: Second parameter of the elastic trip generation function in the transport model. It 

is the maximum amount of trips that a user of the category is willing to make in the time period of simulation 

when travel disutility tends to zero. 

Demand Elasticity Parameter: Parameter of the elastic trip generation function in the transport model. It is the 

elasticity of the category to make more or fewer trips in the time period of simulation, from the minimum to the 

maximum previously defined depending on travel disutility. 

 

 

 

CChhooiiccee  SSeeccttiioonn  

Mode Choice Elasticity: Parameter multiplying the utility function in the logit or powit modal split model. 

Mode Choice Logit Scaling: Sets the degree of scaling in the modal split logit model. Must be from zero to one 

(recommended value = 1). Does not apply to powit models. 

Path Choice Elasticity: Parameter multiplying the utility function in the logit or powit path choice model. 

Path Choice Logit Scaling: Sets the degree of scaling in the path choice logit model. Must be from zero to one 

(recommended value = 1). Does not apply to powit models. 

AAvvaaiillaabbllee  MMooddeess  SSeeccttiioonn  

Fill the corresponding check marks to define which modes may be used by each category. 
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TTrraannssppoorrtt  AAddmmiinniissttrraattoorrss  

Administrators are in charge of the physical supply of transport or infrastructure, that is, roads, metro lines, 

parking facilities, ports, and so on. Physical supply is represented as links grouped into link types. Each link type 

must be assigned to an administrator. Usually, the government administrates most of the transport infrastructure, 

but there may be others, like private concessionaires, railway companies, and so on, or local and federal roads. 

Administrators may impose charges to vehicles and must pay for maintenance costs. 

The only attributes given to transport administrators are an Id number, a name and a description. 

AAddmmiinniisstteerreedd  LLiinnkk  TTyyppeess  SSeeccttiioonn  

Link types are assigned to administrators with the Link Type command of the Transport menu. The Administered 

Link Types Section only displays the assignments that have already been made. 

TTrraannssppoorrtt  MMooddeess  

 

 

Modes are the most general definition of the operative supply of transport, such as: private mode, public mode, 

freight mode, etc. Several operators may be part of a mode, and in turn an operator may have many routes. This 

menu contains only one data section. 
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DDaattaa  TTaabb  

PPaatthh  OOvveerrllaappppiinngg  ((OOzz))  FFaaccttoorr  

Oz Factors control the degree of dispersion of paths with respect to the minimum path. If Oz=0 path search will 

only find the minimum path. As this value increases, more paths are generated, and the resulting paths become 

more distinct, avoiding irrelevant options. The Oz factor assigned to a mode also serves as a default value to all 

operators and link types that belong to the mode, but they may be changed individually with the command 

Transport → Link Types. 

MMaaxxiimmuumm  NNuummbbeerr  ooff  PPaatthhss  

The path search algorithm will select all paths between zones that satisfy the Oz Factor criteria, up to this 

predefined maximum number of paths. 

AAlltteerrnnaattiivvee  SSppeecciiffiicc  CCoonnssttaanntt  

Modal constant added to the disutility of a path. 

TTrraannssppoorrtt  OOppeerraattoorrss  

Operators provide a transportation service, such as bus companies, metros, light truck operators, and so on. In Tranus 

private cars, pedestrians, cyclists and other self-providers are also defined as operators. Each operator has a specific 

vehicle type to provide the service. Operators that belong to a public mode may have several routes. Most of the input 

data required to describe an operator are measured in vehicles units. Some operating characteristics depend also on 

the link type, and are defined with the Transport→Link Types command. 

The main Operator window contains a list of previously defined operators. The edit window shows each operator 

identified by a number, name and description, and the mode the operator belongs to and its type. The rest of the 

information is organized in several sections as described below. 
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MMooddee  

All operators must be assigned to a specific mode. Users may transfer between operators of the same mode, but 

transfers between operators of different modes are not permitted.  

TTyyppee  

Each operator must be assigned to one of four types available. The type assigned to a mode cannot be changed 

after it is defined. If you change of mind after defining an operator type, you must delete the operator and create 

a new one with the correct type. The following types are available:  

1 Normal: Operators such as cars and trucks that can use any permitted link type. Cannot have routes. 

Must respect turn prohibitions. 

2 Transit: A public mode operator without routes. May use any permitted link types. The frequency 

and number of vehicles is a function of demand. Vehicles must respect turn prohibitions, but users may 

transfer.  

3 Transit with Routes: Public operator with specific routes. Each route must be defined with the 

Routes command, specifying the operator to which the route belongs to, and its frequency. The route 

may be assigned to links of the network interactively with the Define Route button, or with the Links 

command. 
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4 Non-motorized: A public mode operator type to define pedestrians, or cyclists. No waiting times are 

calculated. Ignores prohibited turns. Has a constant speed independent of congestion. 

BBaassiiccss  SSeeccttiioonn  

Parameters to define the basic characteristics of the operator. 

Modal Constant: A factor penalizing (multiplying) the value of travel time, to represent subjective elements 

such as comfort, reliability, etc. Usually =1 for the best operator and greater for the others.  

Path ASC: An additive penalty to the operator. Additional to the modal constant. 

Occupancy Rate: Number of demand units (passengers or Tons) per vehicle. Usually maximum vehicle 

capacity for transit, and average occupancy for cars or freight. 

Time Factor: A factor that expands the capacity of a transit operator. Capacity is calculated as a function of 

the frequency and the occupancy rate of vehicles. Usually frequencies are specified in terms of the number 

of vehicles per hour, and this factor is used to represent the number of hours in the simulation period (2 

hours, all-day, etc.). 

Fixed waiting time: Fixed element of the waiting time function for the operator. Waiting times are 

calculated from frequency, demand and other variables. The fixed value is added to the result of these 

calculations to represent additional time needed to board the operator, such as check in a flight, buying 

tickets for the metro an so on. In scehduled routes, this is the only component of the waiting time. 

Has Return Trips: Filling the checkbox indicates that the model should consider empty or loaded return 

trips for the operator, in the proportion indicated by % Return Trips. Leaving the checkbox empty indicates 

that no return trips will be considered in the simulation.  

% Return Trips: A value between 0% and 100% indicates the proportion of vehicles that may attract 

demand on their empty return trips. A value of zero means that vehicles cannot attract loads on their return 

trips, while a value of 100% means that all vehicles may capture loads on their return trips, if there are any. 

TTaarriiffff  SSeeccttiioonn  

Parameters to define the tariff function of the operator. 

Boarding Tariff: Fixed element of the tariff function. Monetary cost that the operator charges to the user 

on boarding the vehicle. 

Distance Tariff: Distance-related element of the tariff function. Monetary cost per unit of distance that the 

operator charges to the user. 

Time Tariff: Time-related element of the tariff function. Monetary cost per unit of time that the operator 

charges to the user. 

BByy  CCaatteeggoorryy  SSeeccttiioonn  

Factors that apply to the tariff and the modal constant of the operator for specific categories to represent 

preferentes. 

Tariff Factor by Category: Multiplies the Tariff of the operator for the specified categories. Used to 

represent reduced tariffs for some categories like students or retired. Default value = 1. 

Penalty Factor by Category: Multiplies the Modal Constant of the operator for the specified categories. 

Used to represent that some categories may have different perception of the operator characteristics Default 

value =1.  
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Path ASC by Category: Alternative Specific Constant that is added to the disutility of an operator that is 

part or a path, as perceived by a specific category. 

EEnneerrggyy  SSeeccttiioonn  

Parameters of the Energy Consumption Function for vehicles of the operator. Each operador may use energy in 

different units and types, such as litres of gasolina, galons of diesel oil, KWH, etc. 

Energy Minimum: Minimum consumption of energy per unit of distance traveled by a vehicle of the 

operator. Corresponds to consumption at optimal speed.  

Energy Maximum: Maximum consumption of energy per unit of distance traveled by a vehicle of the 

operator. Corresponds to consumption as speed approaches zero. 

Energy slope: Parameter of the energy consumption function that controls the slope of the curve from the 

maximum to the minimum energy values, as speed increases from zero to optimal speed.  

Energy cost: Monetary cost per unit of energy consumed by an operator. 

CCoosstt  SSeeccttiioonn  

Parameters of the operating cost function for vehicles of the operator. 

Constant operating cost: Fixed element of the operating cost function of vehicles. In most cases represents 

administrative costs, pick-up and delivery costs, parking and other elements that do not depend on the length 

or duration of the trip. 

Time operating cost: Operating cost per unit of time. Usually represents the driver's salary. Capital 

payments may be included here also. 

% Operating cost paid by user: This value multiplies the operating cost to be transferred to users in the 

form of tariff. When tariffs depend on operating costs, usually a value of 1 plus a profit rate is specified. 

The resulting tariff is in addition to any other tariff elements that might have been defined.  

TTrraannssppoorrtt  →→  TTrraannssffeerrss  

A matrix to define transfer costs between operators, in a from-to operator fashion. May be used to define 

integrated tariffs or to represent different transfer costs in freight. When a boarding tariff is defined with the 

Transport-Operators command, it is automatically assigned to the entire column of the operator in the transfers 

matrix with a gray color. To define an integrated tariff, edit the corresponding cell of the matrix. The input value 

will be colored green to show that it is not the default value. 

When the transport model evaluates a transfer from operator A to operator B, it will charge the tariff indicated in 

the corresponding cell. Input 'Inf' in a cell to indicate a prohibited transfer between operators of the same mode. 

No transfers are allowed between different modes, so the corresponding cells in the matrix of transfers are 

colored gray and cannot be edited.  

TTrraannssppoorrtt  --  RRoouutteess  

Specific routes must be defined for operators of type 3 (transit with routes) in order to become effective. First a 

route must be defined, specifying the operator to which the route belongs and its frequency values. Then the 
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route may be assigned to links of the network with the Links command, by clicking on a link in the network view 

or by using the Define Route button. Routes may also be imported with lists – see Import Network. 

The Routes command displays a list of the routes that have already been defined. Selecting a route shows the 

edit window with two or three sections. 

Note that the copy button provided in the Routes command will create a new route based on a previously defined 

route in the list. This includes the characteristics of the source route and the sequence of links it follows in the 

network. This may be particularly useful when a new route is to be defined that is similar to an already defined 

one. Make the copy and then edit the differences. 

Double-click on any route in the list, or select it and the use the Edit button or Ctrl+E to trigger a route-specific 

dialog box, as follows: 

 

 

 

The route-specific box changes appearance depending on whether a database file or a results file are open. If it is 

a datafile two tabs are displayed: Data and Profile. If it is a results file, a third tab is presented called Indicators. 

DDaattaa  SSeeccttiioonn  

UUsseedd  CChheecckkbbooxx  

To eliminate a route from a specific scenario, clear the checkbox Used in the Data Tag of the Edit dialog. The 

route may be used in some other scenario. This is different from deleting the route, in which case the route is 

eliminated in all scenarios. 

It is also possible to access directly to a route window by double-clicking on the list of routes to the left of the 

Routes view. 
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FFoolllloowwss  SScchheedduullee  CChheecckkbbooxx  

If this checkbox is selected, the waiting time for a specific route is calculated as a minimum plus half the 

interval. For example, is the minimum waiting time has been set to 2 minutes and the frequency of the route is 15 

vehicles per hour, the interval will be 60/10 = 6 minutes between vehicles. Waiting time will be 2+(6/2) = 5. The 

theory is that passenger arrive randomly to the stop, so that on average they will wait half the interval. 

In many cases, however, the frequency of a service might be very low, such as every two hours. In such cases 

passengers usually now the time table or schedule of the service. This is very common in bus, rail or air 

interurban routes, or in suburban areas with limited services. To represent this in the model, unmark this 

checkbox, which tells the model that waiting time is equal to the minimum, and does not depend on frequency. 

The minimum is specified in Transport→Operator as Minimum Waiting Time. 

OOppeerraattoorr  

The data tab provides a pull-down list to select the operator to which the route belongs. It shows the full list of 

operators of type 3 (transit with routes). 

Once an operator is assigned, it may be changed in any scenario, but doing so changes the operator of the route 

in all scenarios. If the intention is to change the operator of a route for a specific scenario without affecting 

others, then make a copy of the route, change the operator of the new route and declare the old route as ‘not 

active’. 

FFrreeqquueennccyy  

Two fields define the frequency range in vehicles per unit of time (usually the hour) . When the frequency is 

given as a range, the transport model will estimate the value within the range from demand, with the 

corresponding waiting times. To set a fixed frequency input the same value in both fields of the range. When 

there is a range and demand increases, the model estimates whether it is convenient to the operator to increase 

the frequency and to what extent. For this the model uses a specific algorithm explained in Mathematical 

Description. If maximum frequency is less than the minimum, the program assumes that max = min. 

TTaarrggeett  OOccccuuppaannccyy  

The last field in the Data tab defines the Target Occupancy of the route, and must be less than 100%. This value 

applies only when the frequency is defined as a range. If the route gets saturated the operator will consider 

increasing the frequency, represented in an algorithm described in Mathematical Description. Target Occupancy 

is one of the parameters in the algorithm. Reasonable results are obtained when this parameter is set to 0.6 to 

0.7. If the frequency of the route is fixed (minimum=maximum) this parameters has no effect. 

MMaaxx  FFlleeeett  

This parameter is only effective if minimum frequency is not equal to maximum frequency. The procedure is 

describer in Mathematical Description. If the result of the calculation is that the operator should increase the 

frequency within the range, the program checks that the value of Max Fleet is not violated. There are several 

reasons to keep the fleet under a certain level, mostly to keep it under control. Take into account that is speeds 

become very low due to congestion, a large fleet is required to maintain frequency. If the value of Max Fleet is 

set to zero or blank, it has no effect. 
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PPrrooffiillee  SSeeccttiioonn  

This tab changes on whether a database or results file is open. If it is a database, the window has the following 

form: 

 

 

The small triangles to the left of some links indicate ‘singular points’ in the itinerary of a route, such as terminals 

or points where the route crosses itself. 

The Profile tab shows the list of links the route is assigned to. Five buttons are available to change the 

characteristics of the route: 

 Passes and stops: indicates that the route passes along the link in the scenario and travelers may transfer or 

alight.  

 Passes only: indicates that the route passes along the link but does not have a stop. 

 Cannot pass: indicates that the route doesn't pass along the link in the scenario. Maybe in some other 

scenario. 

 Add links: This button is used to add links to the route itinerary. Several links may be selected with the 

standard Windows selection method (using Ctrl while clicking links on the list) 

 Remove links: completely removes the route from the link from the database, that is, all scenarios. Use with 

care. 

When the active file is of T3S type, the Links tab shows demand of the route in the current link, and an 

Indicators Tab is added to show the performance indicators. The following information is displayed in the Links 

tab: 
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Link: The links that form part of the itinerary of the route in topological order. 

Capacity: Capacity of the route in each link. For fixed routes capacity will be the same for all links. 

It is calculated as the occupancy of the operator (in Transport → Operator ) multiplied by 

the frequency. 

Demand: number of passengers on the route in the link 

Dem/Cap: Demand/Capacity ratio 

Speed: Speed after capacity restriction 

Seats: Available capacity at the beginning of the link 

Board: number of passengers that board the route at the beginning of the link 

Alight: number of passengers that get off the route at the end of this link 

Waiting: time boarding passengers had to wait on average 

IInnddiiccaattoorrss  SSeeccttiioonn  

The Indicators Tab, that shows up only when a results file is open, has the following form:  
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Total distance: length of the route (may include return, depending on the way the route was 

coded) 

Total time: time taken by a unit to do the whole route 

Passenger-distance: total distance traveled by passenger of the route (e.g. passenger-km) 

Vehicle-distance: total distance traveled by vehicles of the route (e.g. vehicle-km) 

Vehicle-time: total time traveled by cehicles of the route (e.g. vehicle-hours) 

Pass Dist/Veh time: a performance indicator, the result of dividing passenger-km by vehicle-hours. 

The higher the better because it means that more passenger-km are transported in 

fewer vechicle-hours.  

Avg Speed: average speed along the entire route 

Frequency: Frequency of the route in vehicles per unit of time, an intermediate value 

between minimum and maximum, unless a maximum fleet value has been 

violated. 

Fleet: Effective speed of the route, without considering dead time in terminals, 

maintenance and other similar elements. Must be less or equal to maximum fleet 

if it was specified. 

Critical volume: number of passengers in the most loaded link in the route 
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TTrraannssppoorrtt  --  NNooddeess  

Nodes and links form the graph of the network. Nodes are the points of origin and destination of links. The main 

dialog of the Nodes command presents the list of nodes previously defined. Black square icons identify internal zone 

centroids; red square icons identify external zones. All other nodes appear with a round icon. Polynodes are not 

included in the list. 

All data of the network is referred to links (distance, capacity, speed, routes, etc.). The only data required for nodes 

are the X,Y coordinates to graphically display the network.  

Nodes may be moved with the mouse when the network is displayed by dragging them to appropriate locations (the 

pointer must be in Move Nodes mode). The coordinates will reflect the change, but the location of nodes does not 

affect the properties of the network for the transport model. New nodes may be created with this menu or with the 

pointer by double-clicking on any point. Nodes may be imported also from a list with the command Import Network. 

TTrraannssppoorrtt  →→  LLiinnkk  TTyyppeess  

To simplify the coding of the network, links are grouped into link types. Some properties of links will remain unique, 

such as length and capacity, but others will be common to all links of the same type.  

Link types may be used to define different types of roads and to distinguish them from walkways, rail lines, ports, 

bus-only lanes, or whatever is thought to be appropriate in the application. The main window lists all previously 

defined link types. Each link type has an Id number, a short name and a description. Selecting a type from the list 

presents the Edit window with two sections: Data and Operator Data.  

DDaattaa  SSeeccttiioonn  

Administrator: An administrator is the entity in charge of a set of link types. Administrators pay for 

maintenance costs and may charge tolls. Each link type must be assigned to an administrator. Administrators 

are defined in the Transport-Administrators window. 

Capacity Factor: Multiplies the capacity of links. Usually capacity is coded in vehicles per hour. A value 

greater than 1 is used if the simulation period is greater than one hour, such as daily trips. Capacity Factors 

are ignored in the case of links with undefined capacity. 

Minimum Maintaining Cost: The cost of maintaining one distance unit (e.g. Km) of a link type in very low 

traffic conditions. The marginal maintenance cost imposed by vehicles may be specified in the Operator 

Data of the Link Type menu. If the marginal costs are not known, the minimum value may be used to 

represent average cost. 

% speed when V/C = 1: First parameter of the capacity restriction function. Represents the percentage by 

which speed is reduced when the volume/capacity ratio reaches a value of 1.0. 

% max speed reduction: Second parameter of the capacity restriction function. Percentage by which speed 

is reduced when the Volume/Capacity ratio is very high. Must be greater than the previous parameter and 

less or equal 100%. 

V/C at max reduction: Third parameter of the capacity restriction function. Sets the volume/capacity ratio 

at which speed becomes minimum. Must be > 1.0. 
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OOppeerraattoorr  DDaattaa  SSeeccttiioonn  

This tab displays a matrix with one row for each operator, and columns to specify the following items:  

Speed: Free flow speed for each operator in the link type. If an operator has speed = 0 for a specific link 

type, the operator is not allowed to use it. For example, buses will have speed = 0 in rail links.  

Charges: Administrators may charge for the use of some link types a certain amount per unit of distance per 

vehicle (e.g. tolls or road pricing). Operators pay for using the link type and this charge becomes part of 

their operating costs. In turn, operators may transfer all or part of this cost to users. 

Penalization: A positive number to represent subjective elements of a link type that affect operating 

conditions. Usually in relative terms. A value of 1 (default) implies that there are no special elements to 

consider.  

Distance Cost: Monetary cost per unit of distance per vehicle of an operator using the link type. One of the 

components of the operating cost function of vehicles.  

Equivalent Vehicles: Multiplies the number of vehicles to transform them into standard or equivalent 

vehicles. The automobile is usually taken as the standard unit (PCU) with a value of 1.0. Buses and trucks 

will have higher values, depending on the link type.  

Overlapping factor: This optional value is in addition to the overlapping factor specified for the mode (all 

operators in all link types). It is used to represent the hierarchy of roads. Higher level roads should have 

smaller overlapping factors. 

Marginal Maintenance Cost: Is the marginal cost of maintenance per unit distance imposed by vehicles of 

a specific operator traveling along a particular link type. For example, heavy vehicles will have higher 

values than light ones. 

TTrraannssppoorrtt  --  LLiinnkkss  

Links and nodes are the main elements that define the transport network. To simplify the coding of the network, 

links are grouped into link types that share many common characteristics. A few attributes, however, must be 

defined individually for each link in this menu.  

The main dialog presents the list of links previously defined in the database, identified by their origin and 

destination nodes, name (if any) and the link type to which the link belongs. A small icon with an arrow to the 

left of each link in the list indicates if it is a one-way or two-way link. The number of links showed depends on 

the filter applied to the list: Show All, Show Used Only or Show Changed Only. 

Clicking on a link in the list displays the Edit Dialog with four tabs or sections: Data, Operators, Routes and 

Turns. An additional section appears when the active window belongs to an output file of type T3S, and contains 

the Assignment results of the link. The same dialog appears when double-clicking on a link in the network view.  

DDaattaa  SSeeccttiioonn  

A 'Two-way' checkmark creates a link in the opposite direction with identical characteristics, except for turn 

prohibitions or routes. The Reverse button toggles from one direction to the other. Once a link is declared two-

way, any change in one direction automatically changes the attribute in the opposite direction. This dependence 

is broken if the checkmark is unselected.  

Clearing a second check mark 'Used in Scenario' removes the link from the selected scenario, but may remain in 

other scenarios. By contrast, when a link is 'deleted' (with the Delete button of the main dialog) it is removed 

from the database in all scenarios. 
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The following attributes must be defined for each link:  

 Distance: length of link. This value may be obtained by clicking on the 'calculator' icon, in which case 

the link length is calculated from the coordinates of nodes and the 'link length multiplier' parameter of 

the Project→Options→Transport menu (also shown here). 

 Capacity: in equivalent vehicles units, usually per hour. 

 Link Type: choose from any of the previously defined link types. 

 Name and description: the name is displayed in the network view if the corresponding option is 

selected in the View→Options→Links menu. 

AAvvaaiillaabbllee  OOppeerraattoorrss  SSeeccttiioonn  

The dialog displays a list of allowed operators for that type of link, as defined with the Link Types command 

Operators tab. Only informative and cannot be changed in this window. To change this, go to the 

Transport→Link Type→Operator Data menu. 

RRoouutteess  SSeeccttiioonn  

When the active window belongs to the database file (extension .tuz) a list of routes crossing the link is 

displayed with one of three possibilities:  

 Stops: The route passes and is allowed to stop along the link (bus stop sign)  

 Pass: the route passes through the link, but cannot stop along the link (green light icon)  

 Don't Pass: the route does not use the link (red light icon) in the current scenario, but maybe in another 

scenario  

To change the condition of a route in the link, select the route from the list and press one of the three buttons 

provided. 

To add a route to the link in a specific scenario, select the scenario from the tree and click the Add button. The 

Add Routes dialog presents the list of all routes previously defined with the Routes Command. Select the route 

to add and press OK; the route will appear assigned to the link with the Pass condition, which may be changed at 

will. 

To remove a route from the link in all scenarios, select the route from the list and use the Remove button.  

When the active window belongs to the results of the assignment process (file *.t3s) the Route Tab of the same 

dialog shows assignments results for each operator/route using the link. In this case the following information is 

given for each route: 

 Route number and name 

 Capacity of the route for the simulation period 

 Demand (number of passengers on the route in the link) 

 Demand/Capacity ratio 

 Speed after capacity restriction 

 Vehicles 

 Equivalent vehicles 

 Seats (surplus capacity at the beginning of the link) 

 Board (number of passengers that board the route at this link) 
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 Alight (number of passengers that get off the route at this link) 

 Waiting (time boarding passengers had to wait on average) 

To save this information in a file use program IMPTRA. Additional information is obtained by double-clicking 

on any of the routes. 

TTuurrnnss  SSeeccttiioonn  

Displays a list of nodes to which the current link is connected. Selecting a node in the list activates two buttons: 

Turns OK and Cannot Turn. The first is the default condition, and a Delay value may be defined, using the time 

units of the model (usually the hour). The second button can be assigned to prohibit the turn; the Delay column 

will show the word 'Inf'. Alternatively, 'Inf' may be typed directly.  

AAssssiiggnnmmeenntt  SSeeccttiioonn  

When the active window belongs to an output file of type T3S, the Assignment Section shows the main results of 

the assignment in the link.  

AAssssiiggnnmmeenntt  TTaabb  LLeefftt  SSiiddee::    

Contains the global results of the link (all operators and routes using it). Includes: 

 Capacity: capacity of the link for the simulation periods (one hour, peak period, all day, etc.)  

 Speed: free flow reference speed (usually corresponds to the auto operator)  

 Final speed: after capacity restriction (under congestion conditions)  

 Service Levels: from A to H (extension of the HCM standards) 

 Trips: in demand units (potentially misleading if there are passengers and freight in the link)  

 Total Vehicles  

 Total Equivalent Vehicles (usually in PCU units) 

Use program IMPTRA to store these results in a file with a variety of options and formats.  

AAssssiiggnnmmeenntt  TTaabb  RRiigghhtt  SSiiddee::    

The Right side of the Assignment Tab contains the following queue information: 

 Vehicles in Queue: Number of vehicles in the current link, delayed by downstream congestion. 

 Delay Time: Vehicles entering the current link will have the indicated delay time, additional to any 

possible turn delay. 

 Delayed Vehicles: The indicated number of vehicles in the upstream links are delayed by congestion in 

the current link. 

TTrraannssppoorrtt  --  EExxooggeennoouuss  TTrriippss  

In an integrated activities/transport model, the Exogenous Trips command is used to input additional trips not 

simulated by the model, such as through trips or perhaps freight trips. In a transport-only application, all trips are 

specified as exogenous.  
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There are two types of external trips: by transport category and by category and mode. In the transport model, 

external trips by category skip the trip generation stage, they are separated by mode and then assigned to the 

network. External trips by category and mode skip both generation and modal split.  

This command provides two combo boxes to select the type of external trip to be introduced. To define external 

trips by category select it from the Category combo box and All from the Mode combo box. To define external 

trips by category and mode select both the category and the mode in the corresponding combo boxes.  

External trips are common to all scenarios, as defined in the Trips tab. Scenario specific matrices of Factors 

multiply the external trips. Usually the base scenario will have all factors set to 1 and subsequent scenarios will 

have factors >1 to represent growth. For each combination of scenario-category-mode, a default value may be 

set for all factors by introducing the corresponding value in the edit box provided and pressing the button labeled 

'Apply to All'. Individual cells may be then edited. 
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LLaanndd  UUssee  MMeennuu  

Provides several commands to define or edit all land use variables and parameters. The following is the list of 

submenus available.  

Sectors: Defines the sectors into which the urban or regional economy is divided. 

Inter Sectors: Defines the relationships between sectors. 

Economic Data: All data by zone and economic sector. 

Growth Functions: Specifies a number of growth functions for exogenous production. 

When starting a new project only the Sectors submenu is active, because sectors have to be defined before any 

inter-sector functions or growth functions may be specified. In the case of Economic Data both sectors and zones 

must be defined before any data may be input.  

LLaanndd  UUssee  --  SSeeccttoorrss  

The economy of the study area must be divided into sectors. The definition of sectors is very general and 

flexible, and may include productive sectors, such as manufacturing, agriculture, services, etc., as well as 

population types, land uses, floor-space types, or any other. Sectors are given an Id number, short name and a 

description. Boxes are available to fill these items. A box is also provided for a sector type, but this should be 

ignored since this feature hasn't been developed yet.  

There are two types of sectors: transportable and non-transportable. Demand for a transportable sector may be 

satisfied by production in any zone of the study area, while consumption and production of a non-transportable 

sector must take place in the same zone.  

For each sector there is only one section containing four parameters:  

Elasticity: Elasticity is the distribution parameter that multiplies the utility function of the logit or powit 

model. Non-transportable sectors are defined by setting a value of zero to the distribution parameter. This 

also applies to fully exogenous sectors, whose production is not consumed in the study area.  

Price Scale: Two elements make the utility function: price and transport disutility. The price scale weights the 

price element within the utility function.  

Attractor Factor: The attractor factor is an exponent applied to the attractor function of the sector in the 

distribution logit model (default=1).  

Logit Scale: A logit scale parameter sets the degree of scaling of utilities in the logit model. Must be a value 

from zero to one (recommended value =1).  

LLaanndd  UUssee  --  IInntteerr--sseeccttoorrss  

Sectors relate to each other in two ways: sectors may require inputs from other sectors, or may be attracted by 

other sectors. These relationships are defined in terms of inter-sector functions. This command presents a combo 

box with the list of sectors previously defined in the project. Select a sector from the list to define or edit the 

inter-sector functions. There are several sections as described below.  
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IInnppuuttss  SSeeccttiioonn  

The amount of production that a sector m requires from another sector n is defined as a demand function. The 

following elements determine a demand function:  

Minimum demand: is the minimum amount of n required by one unit of sector m  

Maximum demand: is the maximum amount of n a unit of sector m is willing to consume as the price of n 

tends to zero. 

Elasticity: a parameter that regulates the speed at which demand for n decays from the maximum to the 

minimum as the price of n increases.  

SSuubbssttiittuutteess  SSeeccttiioonn  

If a sector requires inputs from more than one producing sector, some of the corresponding demand functions 

may be declared as substitute sets. For example, residents may consume high or low-density residential land, in 

which case both types of land form a substitutes set. A discrete choice model estimates the distribution of 

demand to sectors within a substitute set. 

To define a substitute set first specify an elasticity parameter and a logit scaling parameter (from 0 to 1); then 

select the substitutive sectors by typing a penalty value. Several substitutions sets may be defined. 

EExxooggeennoouuss  aattttrraaccttoorrss  SSeeccttiioonn  

The production of any sector may be partly exogenous or endogenous (induced). Increments in exogenous 

production must be given by zone and/or as a study-wide increment to be allocated to zones by an incremental 

model based on attraction functions. Zonal increments and the study-wide increment must be specified with the 

Economic Data command. The Inter Sector window only contains the definition of the attraction functions.  

Several elements may be combined to define an attraction function. Any sector, including the sector whose 

attraction function is being defined, may participate with the following characteristics, all referred to the 

previous time period: 

 production  

 price  

 excess capacity (maximum restriction - production)  

Weights must be given to each of these elements in the corresponding cells, plus global weights for the attracting 

sector.  

PPrroodduuccttiioonn  aattttrraaccttoorrss  SSeeccttiioonn  

Demand for transportable sectors is allocated to production zones with a discrete choice model. The utility 

function is multiplied by an attractor term. The attractor term is also a function defined as the weighted sum of 

the production of one or more sectors in the previous period including the sector being attracted.  

CCaatteeggoorriieess  SSeeccttiioonn  

Transport demand categories are formed by flows of one or more transportable sectors. Also, an economic flow 

may give rise to several transport categories. This relationship works both ways: in the activities-to-transport 

direction, flows generate transport categories; in the transport-to-activities direction, transport costs and 
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disutilities by categories are transferred to the sectors that generated the flows. In order to link a sector to 

transport categories, the following elements must be defined. 

TTyyppee  ooff  ccaatteeggoorryy  

There are two types of transport categories: Type 0: Normal flow; Type 1: Commuting flow  

TTiimmee  ffaaccttoorr  

Activities and transport categories may refer to different time scales. Usually activities are represented in 

monthly or yearly units, while transport categories are represented in daily or even peak hour time units. Time 

factors relate the two in the following fashion:  

 Normal flows are divided by the time factor in the activities-to-transport direction  

 Commuting costs are multiplied by the time factor in the transport-to-activities direction  

VVoolluummee  ffaaccttoorr  

Activities and transport categories may refer to different physical units, e.g. monetary flows vs. Tons. Volume 

factors relate the two in the following fashion:  

 Multiply flows in the activities-to-transport direction and divide costs in the opposite direction.  

FFllooww  ttoo  pprroodduuccttiioonn  aanndd  ffllooww  ttoo  ccoonnssuummppttiioonn    

The activities model generates the flows from consumption to production zones (the way the money goes). Set 

these values in the following cases:  

 Flow to production >0 if the transport category flows in the same direction  

 Flow to consumption >0 if the transport category flows in the opposite direction  

 Both parameters >0 if the transport category flows both ways, e.g. total day commuting trips.  

LLaanndd  UUssee  --  EEccoonnoommiicc  DDaattaa  

For the base year, data must be introduced for each sector and zone. The base year must contain a full set of 

observed data for all sectors and zones, introduced as production (exogenous or induced columns). The rest of 

the fields depend on the type of sector.  

For future scenarios, increments must be specified to the exogenous production and can be introduced also to 

other variables if appropriate. This may be done either as study-wide increments, zonal increments, or both.  

The Economic Data window presents a pull-down list of sectors previously defined and two additional boxes to 

distinguish between base year data and future scenarios increments. Each box presents the data organized in 

three sections: Internal Data, Imports and Exports. Through the Clipboard data may be copied from a 

spreadsheet and pasted in place. 

Some restrictions apply to the edition of the data. Internal Data belongs to the Base Year exclusively and cannot 

be edited unless the base scenario is selected from the scenario tree. Increments correspond to future scenarios 

and can only be changed if any scenario except the base is selected. The following table shows the edit actions 

that can be done: 
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Selection 
Edit 

Scenario Data Box 

Base Year Base Year Base year data 

Base Year Increment Not allowed 

Future Scenarios Increment Future increments 

Future Scenarios Base Year Not allowed 

 

IInntteerrnnaall  DDaattaa  SSeeccttiioonn  

Presents a matrix containing the list of internal zones and columns for the related data.  To edit the data first 

select the Base Year box and the Base Year Scenario from the left panel. To introduce increments first select a 

future scenario and the Increment box. 

The data increments introduced to exogenous variables in future scenarios will be added to the amount available 

in the previous scenario in the tree. The items in the Internal Data matrix are described bellow. 

Exogenous production: The production of a sector not simulated in the model. Its future growth must be 

given. There must be at least one sector with exogenous production. Sectors may contain both exogenous 

and induced production. 

Induced production: Endogenous production or activities are calculated by the model by means of demand 

functions, and spatially located by the activities model. Observed data must be specified for the base year. 

No increments can be specified for induced production in future scenarios.  

Minimum production: Minimum amount that can be produced  or minimum number of activities that can 

be located (minimum constrain to production).  

Maximum production: Maximum amount that can be produced or maximum number of activities that can 

be located (constrain to production). Maximum production must be greater or equal to minimum production. 

Exogenous demand: Amount demanded by activities outside the study area or explicit final demand  

Price: Unit price of production. Must be consistent with the time units of the activity model. Prices 

indicated in the base year are used by the model as starting values in the production-consumption chain. At 

convergence the model will produce the prices estimated as result of that chain. Consequently, no 

increments may be specified for prices in future scenarios.  

Value added: Value added to one unit of production. The cost of inputs needed to produce one unit plus the 

value added forms the Production Cost per unit of the sector. Must be consistent with the time units of the 

activity model. 

Attractors: Positive value to represent subjective and non-modeled elements attracting the location of 

activities or production in specific zones. 

IImmppoorrttss  SSeeccttiioonn  

Presents a matrix with the external zones defined in the model and three columns to define the amount of imports 

of the selected sector from each zone in the form minimum and maximum. For fixed values 

minimum=maximum. In the third column, an attractor must be defined if there is some import. The default 
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should be 1 if there are imports, zero otherwise. Imports compete with internal production of sectors demanded 

in the study area.  

EExxppoorrttss  SSeeccttiioonn    

Presents a matrix with the external zones defined in the model and just one column to define the amount of 

export of the selected sector to each zone. Exports are exogenous data that must be given to the model. Changes 

in exports for future periods must be estimated outside the model and introduced to the Economic Data selecting 

the Increment box and the corresponding scenario from the left panel.  

LLaanndd  UUssee  --  GGrroowwtthh  FFuunnccttiioonnss  

Attractor functions are used to allocate a global increment to zones. This menu is an alternative to the linear 

functions provided in the Exogenous Attractors Section of the Land Use-Intersectors Menu, providing instead 

three functions: linear, power and logarithmic.  

The New or Edit buttons open a dialog to create a new attractor function or to edit a previously defined one. 

Each function is identified with an Id number and the following data must be defined.  

FFuunnccttiioonn  ooppttiioonnss  

Select the type of function to use: linear, power or logarithmic  

SSeeccttoorr  ttoo  aallllooccaattee  

A pull-down box contains all the sectors defined in the project. Select a sector to define a growth function to 

some of its variables. 

VVaarriiaabbllee  ttoo  aallllooccaattee  

There are four variables of the selected sectors to which growth functions can be defined:  

 XPRO: exogenous production 

 XDEM: exogenous demand 

 RMIN: minimum restriction 

 RMAX: maximum restriction 

DDaattaa  TTaabb::  ddeeffiinniinngg  tthhee  ffuunnccttiioonn  

This tab contains the elements required for the selected function. The function can contain a maximum of six 

terms: an optional constant term and up to four independent terms. Each independent term is formed by: a sector, 

a variable of that sector and a parameter.  

GGlloobbaall  IInnccrreemmeenntt//DDeeccrreemmeenntt  

Amount of the selected variable to add or subtract to the amount allocated in the previous scenario in the tree.  
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CCoonnssttaanntt  tteerrmm  

Optional constant term for the selected function. 

AAttttrraaccttoorr  sseeccttoorr  

Any sector can be defined as an attractor of the variable been incremented. A pull-down box contains the list of 

all sectors in the project.  

VVaarriiaabbllee  

A variable of the attractor sector that attracts the location of the global increment. For each zone, the program 

considers the amount of this variable in the previous period. There are seven variables of the selected sector that 

can be included in the function.  

 XPRO: exogenous production  

 XDEM: exogenous demand  

 RMIN: minimum restriction  

 RMAX: maximum restriction  

 TPRO: total production  

 PRIC: price (or rent) of the sector  

 CAPA: capacity (difference between maximum restriction and production)  

PPaarraammeetteerr  

Parameter that applies to the selected variable of the attractor sector. 
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MMoouussee  MMeennuu  

Commands in this menu change the action of the mouse pointer for the interactive edition of the network. The 

pointer modes may also be selected from the icons in the tool bar or with a short-cut key combination. The 

function of the pointer for selecting menus, commands, panels and network views is always active with any 

pointer mode. This is also true for selecting an area of the graph by click-dragging a square. The commands of 

the Mouse Menu only affect the interactive edition of the network. If no edits need to be made to the network, 

the pointer must be in Normal Mode. The Undo command of the Edit Menu reverts any action performed with 

the interactive edition of the network tools. 

NNoorrmmaall  MMooddee  ((SShhiifftt++CCttrrll++NN))  

When in normal mode, the interactive edition of the network is off.  

MMoovvee  NNooddeess  ((SShhiifftt++CCttrrll++MM))  

With this button, the cursor or pointer looks like a cross-hair and is enabled to move centroids, nodes or 

polynodes by clicking and dragging them around. All links related to the node are adjusted and dragged along 

accordingly, but link lengths are not modified. This is useful to move nodes away from a congested area and 

gain clarity. Later on, the length of links may be changed individually (Transport-Links command) or globally 

(Project-Options command). 

LLaabbeell  NNooddeess  ((SShhiifftt++CCttrrll++LL))  

The command View-Options-Nodes provides facilities to label nodes with Id numbers, names or both. Labels 

may be put on zones only, on all nodes or on ‘selected’ nodes. The function of the Label Nodes button is to 

select which nodes are labeled in the network view, provided that the Selected Nodes of the View-Options-Nodes 

option is active. In this mode, the pointer shows a small label. Clicking on a node selects it for labeling. 

Polynodes cannot be labeled.  

CCrreeaattee  NNooddeess  ((SShhiifftt++CCttrrll++CC))  

The pointer looks like a crossed circle. Double-clicking on any point in the network view opens the Nodes Edit 

dialog, showing a default Id number assigned to the new node (last Id + 1) , and the coordinates of the point. The 

Id number may be changed (avoid repeated Id numbers) and a name and description may be added to the node. 

Note that most network views don’t show nodes that are not used (i.e. with no links associated to it) in the 

scenario being displayed. Only the Changed view displays all nodes. Consequently use this view when creating 

new nodes. 

Polynodes cannot be created with this button. Instead the Split Link button is used. 

 

If instead of double-click to create a node Ctrl+double-click is used, a Zone dialog appears instead of the usual 

Node dialog. In this way zone centroids may be created interactively. 
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CCrreeaattee  LLiinnkkss  ((SShhiifftt++CCttrrll++II))  

Used to create a new link between two existing nodes. The pointer looks like a bar when positioned over a node. 

Select the origin node and drag the pointer to a destination node. The Links Edit dialog opens, showing the 

origin-destination of the new link created as a two-way link by default. This condition may be changed and the 

remaining data assigned (length, capacity, link type). By default the length of the link is calculated from the 

nodes coordinates, assuming a straight line. 

SSpplliitt  LLiinnkkss  ((SShhiifftt++CCttrrll++SS))  

Double clicking on a link divides it into two halves. The Nodes Edit dialog opens showing a default number Id 

for the new node created and its coordinates. This Id number may be changed, and a name and description may 

be added. Each half link will have the following characteristics: 

 half the length of the original 

 same link type as the original 

 same capacity as the original 

 same routes as the original 

 same name and description 

Note that links are split for the active scenario and its dependents down the scenario tree, with the new links with 

the condition Used and the original link as Not Used. For all other scenarios, the original link remains as Used 

and the new couple of links as Not Used. 

This button must be used to create polynodes as part of a link. Create as many intermediate nodes for a link. 

Then select the nodes and apply the command Edit-Simplify Network (Ctrl+Y). 

DDeeffiinnee  RRoouuttee  ((SShhiifftt++CCttrrll++SS))  

This pointer mode is only available in the Routes tab. To assign a route to a link, first select the scenario from 

the tree, then select a route from the list in the Color tab of the left panel, and select the Define Route button. 

The route is assigned to a link by clicking on the link. The following rules apply: 

 The selected route may be assigned to many links with subsequent clicks until the Define Route button 

is deactivated. 

 The Undo command of the Edit Menu (or the Undo button) reverts all assignments made since the 

Define Route button was selected. 

 If the selected route had not been assigned to the link, this button assigns the route and declares it as 

Passes and Stops (see command Transport-Route) 

 If the route had been previously assigned to the link and is either in the condition Passes and Stops or 

Passes Only, this button will declare it as Cannot Pass for the current scenario and its dependents. 

 The route will be assigned in the direction in which the mouse-click was made. If the route passes both 

ways, click both ways. 
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WWiinnddooww  MMeennuu  

Commands of this menu open new windows of the active file, arrange windows currently open or arrange those 

which have been iconized. Clicking on any of the opened windows makes it the active window.  

NNeeww  wwiinnddooww  

Used to open a new window of the active file. Each window can be customized to display a different view of the 

network. A sequential number will be added automatically to the name of each window opened.  

CCaassccaaddee  ((SShhiifftt++FF55))  

Organizes all opened non-iconized windows in the typical Windows cascade fashion. The active window is 

displayed on top of the other ones. Those behind remain with their identifying titles visible.  

TTiillee  ((SShhiifftt++FF44))  

Organizes all opened non-iconized windows in the typical Windows tile fashion. The size of all windows is 

adjusted so that they can all fit within the display area.  

AArrrraannggee  

Several windows may be iconized and restored many times. The effect of this may be that the icons get 

dispersed. Selecting this option causes all icons to be arranged at the bottom of the display area in an orderly 

fashion.  
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SShhoorrttccuutt  kkeeyyss  

For repeated operations it is faster to use key combinations instead of selecting buttons with the mouse. The 

following tables lists all available shortcut keys. 

Menu Command Key Combination 

File Open Ctrl+O 

 Save Ctrl+S 

 Print Ctrl+P 

 Exit Alt+F4 

Edtit Copy Ctrl+C 

 Delete Ctrl+D 

 Merge Ctrl+M 

View All Ctrl+A 

 Refresh  F9 

 Find Node Ctrl+F 

 Zoom Out F7 

 Zoom In F8 

 Show/Hide Left Panel Ctrl+L 

Mouse Normal Mode Shift+Ctrl+N 

 Move Nodes Shift+Ctrl+M 

 Label Nodes Shift+Ctrl+L 

 Create Nodes Shift+Ctrl+C 

 Create Links Shift+Ctrl+I 

 Split Links Shift+Ctrl+S 

 Define Route Shift+Ctrl+R 

Window Tile Shift+F4 

 Cascade Shift+F5 
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GGlloossssaarryy  

% of Vehicle Availability: Proportion of passengers of a transport category that have a vehicle available to 

make the trip. Different from car ownership: a car is not necessary owned, but available, e.g. students taken to 

school in parents' car. 

% Operating Cost Paid by User: This value multiplies the operating cost to be transferred to users in the form 

of tariff. When tariffs depend on operating costs, usually a value of 1 plus a profit rate is specified. The resulting 

tariff is in addition to any other tariff elements that might have been defined. 

% Return Trips: A value different than Inf (default) activates the calculation of return trips in the transport 

model. A value between 0 and 1 indicates the proportion of vehicles that may attract demand on their empty 

return trips. With a value of zero all vehicles will return empty. 

% Speed when V/C = 1: Parameter of the capacity restriction function. Represents the percentage by which 

speed is reduced when the volume/capacity ratio reaches a value of 1.0. 

A 

Administrator: Each link type must be assigned to an administrator. Administrators must have been previously 

defined in the Info/Administrators window. 

Administrators’ statistics: Transport system statistics by administrator: length of links administrated, income 

from charges, total maintenance cost and administration balance (income-cost). 

B 

Boarding Tariff: Fixed element of the tariff function. Monetary cost that the operator charges to the user on 

boarding the vehicle. 

C 

Capacity Factor: Multiplies the capacity of links. Usually capacity is coded in vehicles per hour. Use a value 

greater than 1 if daily trips are being simulated (e.g. 20). Capacity Factors are ignored in the case of links with 

undefined capacity. 

Car Availability: Proportion of people that have a car available for the trip of a specific category. For example, 

proportion of medium income people that have a car available to make the home to work. 

Centroid: Special node in the network to represent zones. All trips start and end in centroids. Zones also contain 

socioeconomic and land use data. 

Charges: Administrators may charge for the use of some link types a certain amount per unit of distance per 

vehicle (i.e. tolls or road pricing). Operators have to pay for using the link type and this charge becomes part of 

its operating costs. 

Constant Operating Cost: Fixed element of the operating cost function of vehicles. In most cases represents 

administrative costs, pick up and delivery costs, parking and other elements that do not depend on the length of 

the trip. 
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D 

Demand Elasticity Parameter: Parameter of the elastic generation function in the transport model. It is the 

elasticity of the category to make more or less trips in the time period of simulation, from the minimum to the 

maximum previously defined. 

Desuts by Category and Mode: Transport disutilities by category and mode. Output of program TRANS, Input 

to program COST. 

Desuts by Sector: Transport disutilities by socioeconomic sector. Output of program COST, Input to program 

LOC 

Distance Cost: Monetary cost per unit of distance per vehicle of an operator using the link type. This parameter 

is one of the components of the operating cost function of vehicles. 

Distance Tariff: Distance related element of the tariff function. Monetary cost per unit of distance that the 

operator charges to the user. 

E 

Energy Cost: Monetary cost per unit of energy consumed by an operator. 

Energy Maximum: Maximum consumption of energy per unit of distance traveled by a vehicle of the operator. 

Corresponds to consumption as speed approaches zero. 

Energy Minimum: Minimum consumption of energy per unit of distance traveled by a vehicle of the operator. 

Corresponds to consumption at optimal speed. 

Energy Slope: Parameter of the energy consumption function that controls the slope of the curve from the 

maximum to the minimum energy values, as speed increases from zero to optimal speed. 

Equivalent Vehicles: Multiplies the number of vehicles to transform them into standard vehicles. The 

automobile is usually taken as the standard unit with a value of 1.0. Buses and trucks will have higher values, 

depending on the link type. 

Executable programs: The simulation models are packaged in a set of executables programs. Once the data has 

been set up, the models should be run in a DOS window. The results of simulations can be explored with this 

interactive module TUS and with specific programs. 

F 

Flows by Category: Flows by transport category, transformed from socioeconomic flows. Output of program 

FLUJ, Input to program TRANS. 

Flows by Sector: Flows by sector result from the simulation of the activity location model. Output of program 

LOC or LCAL, Input to program FLUJ 

G 

Graphic User Shell GUS: GUS is a separate graphic program designed to analyze the transport network in 

more detail. It provides multiple options to graphically show the supply and demand of transport. You can 

explore the path, assignment results, service labels, an many other variables with multiple options of colors and 

representations 

L 

Link Types: The transport network is formed by links. Links types group links with similar operating 

characteristics and have the same administrator. 
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M 

Marginal Maintaining Cost: Is the marginal cost of maintenance per unit distance imposed by vehicles 

traveling along a particular link type. Heavy vehicles will have higher values than light ones. 

Max Waiting Time: Sets an upper bound for the waiting time of transit operators. Waiting times are calculated 

from frequency, demand and other variables. Should the result of these calculations be greater than the specified 

maximum, the latter takes precedence. Particularly useful in cases with very low frequencies, e.g. 2 buses a day, 

to limit the resulting high waiting values. 

Maximum Generation Rate: Parameter of the elastic generation function in the transport model. It is the 

maximum amount of trips that a user of the category is willing to do in the time period of simulation, when the 

travel disutility tends to zero. 

Minimum Generation Rate: Parameter of the elastic generation function in the transport model. It is the 

minimum amount of trips per unit of flow of the category in the time period of simulation. 

Minimum Maintaining Cost: The cost of maintaining one distance unit of a link type in very low traffic 

conditions (e.g. per Km). The marginal maintenance cost imposed by vehicles may be specified in the Operator 

Data of the Link Type window. If the marginal costs are not known, the minimum value may be used to 

represent total cost. 

Modal Constant: A factor penalizing travel time, to represent subjective elements such as comfort, reliability, 

etc. Usually =1 for the best operator and greater for the others. 

Mode Choice Elasticity: Parameter multiplying the utility function in the logit modal split model. 

Mode Choice Logit Scaling: Sets the degree of scaling in the modal split logit model. Must be from zero to one 

Mode: Modes are the most general definition of the operative supply of transport, such as: private mode, public 

mode, freight mode, etc. Several operators may be part of a mode, and in turn an operator may have many 

routes. 

N 

Network view: A network graph for one specific scenario. It can be opened from the tags of the right window 

panel and customized with several commands of the View Menu. 

Node: An essential component of the network. All links begin and finish in nodes. Nodes represent intersections 

or points where a link changes in characteristics. 

Non motorized: A public mode operator type to define pedestrians, or cyclists. No waiting times are calculated. 

Ignores prohibited turns. Has a constant speed independent of congestion. 

Normal type: Operators such as cars and trucks that can use any permitted link type. Cannot belong to a public 

mode. Must respect turn prohibitions. 

O 

Occupancy Rate: Number of demand units (passengers or Tons) per vehicle. Usually maximum vehicle 

capacity for transit or freight operators, and average occupancy for cars. 

Operating Cost per Unit of Time: Time related element in the operating cost function of vehicles. Usually 

represents the salaries of drivers, capital payments and interests. The monetary and time units must be consistent 

with other variables of the transport model. 

Operator statistics: Transport statistics by operator: total trips, units-distance (i.e. Pas-Km), income from tariff, 

energy consumption, total operating cost and operating balance (income-operating costs). 
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Operators: Operators directly provide a transportation service, such as bus companies, metros, light truck 

operators, and so on. Private cars, bikes and even pedestrians must be defined as operators. 

Overlapping factor: This optional value substitute the overlapping factor specified for the mode (all operators 

in all link types); it allows defining specific overlapping factors for some operators and link types. 

P 

Path Choice Elasticity: Parameter multiplying the utility function in the logit path choice model. 

Path Choice Logit Scaling: Sets the degree of scaling in the path choice logit model. Must be from zero to one 

Penal Factor by Category: Multiplies the Modal Constant of the operator for the specified categories. Used to 

represent that some categories may have different perception of the operator characteristics Default value 

equals1 

Penalization: The penalization parameter is a positive number that represents subjective elements of a link type 

that affect operating conditions. Usually used in relative terms. A value of 1 implies that there are no special 

elements to consider. 

Polynode: These are dummy or intermediate nodes in a link to represent curves or special features. They affect 

the length calculation of a link, but otherwise play no role in the transport model. 

S 

Speed: Free flow speed must be specified for each operator in each link type. If an operator has defined speed = 

0 for a specific link type, the operator is not allowed to use it. For example, buses will have speed = 0 assigned 

to rail links. 

T 

Tariff Factor by Category: Multiplies the Tariff of the operator for the specified categories. Used to represent 

reduced tariffs for some categories like students. Default value = 1 

Time Factor: A factor that expands the capacity of a transit operator. Capacity is calculated as a function of the 

frequency and the occupancy rate of vehicles. Usually frequencies are specified in terms of the number of 

vehicles per hour, and this factor is used to represent the number of hours of service in total day simulations. 

Time operating cost: Operating cost per unit of time. Usually it represents the driver's salary 

Time Tariff: Time related element of the tariff function. Monetary cost per unit of time that the operator charges 

to the user 

Total trips: Total trips of the study area by category and mode. 

Transit type: A public mode operator without routes. May use any permitted link types. The frequency and 

number of vehicles is a function of demand. Vehicles must respect turn prohibitions, but users may transfer. 

Transit with Routes: Public operator with specific routes. Each route must be defined with the Routes 

command, specifying the operator to which the route belongs and its frequency. Then the route may be assigned 

to links of the network with the Links command. 

Transport Costs by Category: Monetary transport costs by transport category. Output of program TRANS. 

Input to program COST. 

Transport Costs by Sector: Monetary transport costs by socioeconomic sector. Output of program COST. 

Input to program LOC. 



TUS: Graphic Interface and database TRANUS  
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Tranus User Shell TUS: The application you are using now is the TRANUS User Shell. It makes it easy to 

create a project, providing facilities to introduce and edit input data and to view and analyze the results of the 

models. 

Trips matrices: Trips by category and mode simulated by the transport model. Output of program TRANS 

U 

User statistics: Global and average transport statistics: travel distance, travel time, waiting time, monetary cost 

and disutility. 

V 

V/C at max reduction: Parameter of the capacity restriction function. Represents the volume/capacity ratio at 

which speed reaches a minimum value. Must be greater than 1.0. 

Value of Travel Time: Monetary value that a transport category assigns to one unit of travel time. The units of 

money and time must be consistent with other variables of the model. 

Value of Waiting Time: Monetary value that a transport category assigns to one unit of waiting time. The units 

of money and time must be consistent with other variables of the model. 


